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 كركوك المعهـــد التقنــي                   

 قســم صحــة المجتمــــــــع                  

 الثانيـــــة السنــــــــــــــة                  

 

 

 

 

 

 

 

            

 الحقيبــــة التدريسيـــــــــة لمــــادة :                              

     

 (( ةبـــــــات الحاســــــــــــــــ))  تطبيقــــــ                                     
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 الأسبوع الثالث –الأسبوع الأول 

 

 -:ما المفصود بشبكة الأنترنيت           

 منون أستخدامهالم يعد أحد يسمع بشبكة الأنترنيت وهناك الكثير ممن أستخدموها وهنال الأكثر ممن يت         

 وقد أصبحت شبكة الأنترنيت شريان الحياة لكثير من المؤسسات التي تستخدمها وتعتمد عليها في تبادل              

 .المعلومات         

 التي تقدمها ؟ وكيف نستخدمها ؟ فما هي هذه الشبكة ؟ وما الخدمات         

        

 وصولة مع بعضها والموزعة في جميع أنحاء مالواسعة من الحواسيب عبارة عن شبكة شبكة الأنترنيت :      

 العالم وتخزن كم هائل من المعلومات بأشكال مختلفة مثل النصوص وملفات الصوت ,                            

 تكنلوجبا والرسومات المتحركة , هذه المعلومات تشمل كافة مناحي المعرفة من علوم و                          

 وصحافة  وأعمال وألعاب .                          

 

 سيبم خاصة ) بروتوكولات( للتحكم  بعمليات نقل المعلومات وكمية وتستخدم شبكة الأنترنيت مرا          

 :المعلومات           

  

          (Transmission Control Protocol/ Internet Protocol)  

 

 

 توكولات:البرو     

 ) تعريفه لغويا" على أنه مجموعة من القواعد التي تنظم التفاهم والتعامل بين كيانين أو نظامين                      

 مختلفين من حيث البيئة وأسلوب العمل والتعامل معه .(                      

 لغرض ربط  الشبكات فيما بينها لتكوين  هي برامج وفرتها شركة مايكروسوفت (Web)تعريفه بالنسبة لل        

 شبكة الأنترنيت وهي بشكل عام ثلاثة أنواع :       

 . ( FTP:- File Transfer Protocol)بروتوكول نقل الملفات 1- 

 .( Http:- Hyper Text File Protocol)برتوكول نقل النص الفائق  -2

 ت أو صور أو ألوان .رسوما والمقصود بالنص الفائق الذي يحتوي بضمنه    

 وهو الأكثر أستخدام ويوفر خدمة راقية . ( WWW. World Wide Web)برتوكول  -3

 

 

 عد الخدمة الأوسع أستخداما" في وقتنا الحاضر وسوف نعرف ماذا تعني والتي ت  (WWW) خدمة          

                  (web)  وما الوسائل التي يمكن الوصول الى(WEB) تعامل مع صفحاته ومواقعه .وكيف ن 

 

 

 مهمة في الأنترنيت : تعريفات              

  الويـب(WWW) : هي أختصار للكلمات(World Wide Web )  وهي عبارة عن وسيلة 

 تسهل الوصول الى المعلومات في الأنترنيت فهي أشبه بنافذة نطل منها على                                

 (HTMIL)بلغة أو رموز تسمى الأنترنيت فهي عبارة عن صفحات تكتب                               

 .Browserيمكننا عرضها في حاسوبنا الشخصي بواسطة برنامج يسمى                               
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 هذا  وبمجرد تعلمهو برنامج يعرض لك المعلومات الموجودة في الأنترنيت :  Browserالمتصفح  .          

 :البرنامج نستطيع أن نتنقل في فضاء عالم الأنترنيت ومن أشهر المتصفحات هي              

            ( Internet explorer , Mozilla Firefox , Google chrome)   

 

 رأعتبفكلما زاد رقم الأصدار كلما وتتوافر هذه البرامج بعدة أصدارات   وغيرها من المتصفحات .            

 الأصدار حديثا" ومطورا" عن الذي سبقه وفي كل سنة تطرح الشركات أصدارات مطورا" لهذه             

 المتصفحات .            

           

 هو موقع على الأنترنيت يستخدم برنامج خاص : (Search Engines)محرك البحث  .                  

 لومات في شبكة الأنترنيت ومن أشهر هذه المواقع :للبحث عن المع                   

                 (Yahoo .com , Google.com ,Google .ae)     

           . Download:  هو عملية أنزال البرامج من الأنترنت الى الكمبيوتر. 

           . upload في الأنترنيت . : هو عملية نقل الملفات والصفحات من الكمبيوتر الى موقع ما 

           . chat  :. يعني الدردشة أو الحوار المباشر 

           . Hotmail  :يب ) نذكر أن بريد الكتروني عن طريق استخدام الو هو موقع لشركة شهيرة قدمت أول 

 ليس مصطلحا" من مصطلحات الأنترنيت ( . Hotmailال                                   

 

                  

 من المسؤول عن شبكة الأنترنيت ؟                 

 تحتوي على مهندسين ومحللين ومختصي شبكات تشرف أشراف  (ISCO )هناك جمعية وهي -        

 وتقوم بتطوير برامجيات الشبكة وبدون مقابل .علمي  على شبكة الأنترنيت             

 

 

 نيت :خدمات الأنتر                  

 : وهو نظام برمجي يعمل على شبكة الأنترنيت يتكون من مجموعة كبيرة  من (www)خدمة ال 1-

 المكونة من كم هائل من المستندات المتصلة والمتشعبة . (Hypertext)النصوص الحية     

 نظام لتبادل الرسائل والملفات بين الأشخاص . (E-mail)البريد الألكتروني  -2            

 : وهي عبارة  (news group &mailing lists)د البريدية مجموعة الأختبار والمسار -3            

 عن منتديات الكترونية معقدة لتبادل المعلومات حول موضوع معين .                

 توكول مكتبة : نظام لنقل الملفات من موقع الى آخر ويوفر هذا البروFTPبروتوكول نقل الملفات  -4            

 الكترونية  كبيرة جدا" .                 

 : نظام يتيح أمكانية التحدث الى الآخرين باستخدام الكلمات المكتوبة (Chatting)المخاطبة ال  -5             

 اسوبه سطة لوحة المفاتيح الى شخص آخر يجلس وراء جهاز حامن خلال أرسال الرسالة المكتوبة بو                  

 بانتظار وصول هذه الرسالة والذي يقوم بدوره بالرد عليها مباشرة .                  
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 ان تصبح جزءا" من شبكة الأنترنيت فما عليك سوى أن  أذا أردتنترنيت :  متطلبات الربط أو الأتصال بالأ        

 لديك ما يلي : يكون                                                         

 .جهاز الحاسبة 1-    

 لا بد من وجود مودم متصل بجهاز الكمبيوتر وظيفته ترجمة البيانات من : (Modem)مودم  -2   

 ((Analogالى   (Digital))) وظيفة المودم تحويل الأشارة لغة الى لغة الكمبيوتر الرقمية  أي     

 وبالعكس .                    

                  

 خطوط نقل الأشارة من مكان الى آخر عبر مسافات معينة بين أجهزة الكمبيوتر والمقصود بخطوط  -3                

 النقل خط أشترك بالأنترنيت .                    

 

 

  ما هي أنوع الأتصال بالأنترنيت :                  

 . (Tcp/ Ip)ة بشبكة أي يتصل المستخدم مباشر -الأتصال المباشر : 1-

 PPPالأتصال الهاتفي تسمى هذه الطريقة  (Dial –up)الأتصال غير المباشر  -2

     (Point to Point Protocol) هذا النوع من الأتصال يتم أستخدام الهاتف لتأمين 

 الأتصال بين جهازالمستخدم بواسطة المودم وتقوم شركة خدمة الأنترنيت بوصل المستخدم      

 بشبكة الأنترنيت .     

 

 وسلبياتها : مميزات شبكة الأنترنيت

 

 يزودنا الأنترنيت بكمية هائلة من الوثائق والمعلومات المنظمة والمبوبة في مختلف 1- 

 مخزونة في عشرات الألوف من شبكات المعلومات والمسترجعة عبر الموضوعات والمجالات                        

 ملايين الحواسيب المنتشرة في دول العالم الثالث .                       

 تمثل أخترقا" وأختفاء للحدود الجغرافية والسياسية للدول والأقاليم والقارات وتحويل العالم  -2                   

 الى قرية صغيرة من خلال شاشة حاسوب ومعدات سهلة الأستخدام .                       

 أتصال آلي وفوري مباشر لمواقع وشبكات مختلفة بكلف نداء هاتفي محلي . وسيلة -3                   

 ماتي عند المستخدمين وتطوير المجتمعات من خلال نشرالوعي المعلو تعمل على تثقيف -4                   

 .البحثية وتعاملهم مع مختلف أنواع المعلومات  أمكاناتهم                       

 سهولة الأرتباط بالشبكة من خلال الأنواع المختلفة من الحواسيب المصنعة في العالم وخاصة  -5                  

 الشخصية .الحواسيب                       

 يد ملف أو وثيقة والحصول عليها بدقة وبأقل وقت ممكن في الغالب .دأمكانية تح -6                   

 توفير البرامج والبروتوكولات وأدوات الأتصال المساعدة والمناسبة التي تطورت من خلال  -7                   

 الشبكة وكذلك  الأدلة الأرشادية المساعدة لها .                       

 ع بل جميعهم الشبكة والأستفادة من معلوماتها على شريحة محددة من أبناء المجتم عمللا يقتصر -8                  

 تقريبا" ) الطلبة والتدريسيون وأصحاب الأعمال وشخصيات الأعمال والسياسة والفنيون                        

 وأصحاب الهوايات( .                       
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  كيف يعمل الأنترنيت ؟:            
 ماذا يحدث عندما تطلب موقع على الأنترنيت ؟ ...              

 الى ثلاثة أقسام : URLيقوم متصفحك بتقسيم عنوان الموقع 1- 

 . HTTpالأول : البرتوكول 

 .WWW.c4ARABالثاني : أسم السير فر 

 . INDEX.HTMLالثالث : أسم الملف 

 DNS (DOMAIN NAME SERVERS)تصال بخادم  الأسماء المتصفح يقوم بالأ -2

 المطلوب للأتصال بجهاز  IPالى عنوان  WWW.C4ARAB.comويل أسم الموقع لتح     

 . SERVERالخادم        

 . 80على البورت  IPيقوم المتصفح بالأتصال برقم الآي بي  -3

 ا"طالب SERVERيقوم المتصفح بأرسال طلب الى الخادم  HTTPبأتباع البروتوكول  -4

 . WWW.C4ARAB.com/INDEX.HTMLمنه الملف      

 الى متصفحك . TXTبأرسال ملف  SERVERيقوم الخادم  -5

 ويقوم بعرض  SERVERالمرسل من قبل الخادم  TXTيقوم المتصفح الآن بقراءة ملف  -6

 .الصفحة على شاشة حاسوبك     

  

 

 بمواصفات عالية وخاصة متصل بالأنترنيت على طول وتر يهو جهاز كمي: (SERVER)خــادم ال

 الوقت وتخزن فيه الصفحات والملفات الخاصة بالمواقع .) بعض المواقع                                  

 قع كبيرة , أما بقية يكون لها خادم خاص بموقعها فقط وعادة تكون الموا                                 

 المواقع فيكون فيها الخادم مشتركة فيه عدة مواقع وهو الساند بالنسبة للمواقع                                                

 الصغيرة والمتوسطة  .                                 

 ولديك شرح وتوضيح للواجهة التطبيقية للأنترنيت: 

 

http://www.c4arab/
http://www.c4arab.com/
http://www.c4arab.com/INDEX.HTML
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 من       (search Engine)يتكون عمل محركات البحث عمل محركات البحث في الأنترنيت :               

 ثلاث مراحل :                                             

 الذي يبحر في الأنترنيت لأيجاد  (Spider)المرحلة الأولى : تبدأ هذه المرحلة مع برنامج العنكبوت 

 مؤشرات صفحات جديدة على الويب والأطلاع على محتوياتها ويأخذ هذا البرنامج                      

 وعناوين هذا الموقع .                    

 المرحلة الثانية : تقوم هذه المرحلة بتوصيف صفحات الويب المختارة وفق مجموعة من المعايير مثل 

 ها وتحفظ النتائج في قاعدة بيانات ضخمة .الأكثر تكرارا" من غيرالكلمات                     

 المرحلة الثالثة : تميز هذه المرحلة محركات عن الدليل أذ يلتقط محرك البحث الأستعلام الذي يقوم 

 ويقارنه مع قاعدة البيانات الموجودة لديه باستخدام خوارزميات المستخدم بتدوينه                     

 قة ثم تعرض نتائج البحث المتمثلة بصفحات الويب التي تطابق استعلام المطاب                    

 المستخدم.                     

 

 (.…,Yahoo,google,Hotboot,Acsayt)ومن أشهرالأدلة  ومحركات البحث :

 

---------------------------------------------------------------------------------------- 

نترنيت المصنفة , دون منازع وهو ياهو من أقدم أدلة الأ: يعد (.yahoo.comwww)ياهو

                                         راض المواقع والصفحات الجيدة على الأنترنيت .نقطة أنطلاق جيدة لأستع

 

 : (WWW.GOOGLE.COM)كوكل 

المهمة والشائعة الأستعمال على الأنترنيت وللبحث به أطبع بضع كلمات تصف ما ث أحد محركات البح

لكي تظهر النتائج على  (SEARCH)أو أنقر على مربع  (ENTER)تبحث عنه واضغط مفتاح 

 شكل نافذة .

 

http://www.yahoo.com/
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 : Google)(ملاحظات حول كوكل                 

 

 

 بحثك ولا حاجة لأي شئ بين الكلمات ت يعطيك كوكل الصفحات التي تحتوي على كل كلما1- 

 ليجدها كلها ولتضييق البحث ,زد عدد كلمات البحث .     

 .(COM,http)يتجاهل كوكل الكلمات والأحرف الكثيرة الأستعمال آليا" أشياء أخرى مثل  -2

 يبحث كوكل عن الكلمات كما تظهر في مربع البحث بالتمام فالبحث مثلا"عن كلمة )كتاب( -3

 فلن تكون نتيجة البحث كلمة )كتاب ,مكتوب,مكتب( وأنما تنتج ما يطابق كلمة )كتاب( فقط .    

 عنه كبيرا" أم صغيرا" فجميع الحروف لايأخذ كوكل في الأعتبار كون الحرف اللاتيني الذي يبحث  -4

 كيفما طبعت تفهم على أنها صغيرة .      

 protble Document)ملفات من نوع أن نتائج البحث فيه تشمل من مميزات كوكل  -5

Format)   مختصرا" تكتب ,PDF)  وهو نوع من الملفات التي تتضمن ملف يتألف من دراسة ) 

 تظهر   (PDF)كاملة لموضوع ما )بحث أو تقرير ( ولكي تعرف نتيجة البحث تتضمن ملف نوع   

 اج لبرنامج خاص وهو باللون الأزرق أمام العنوان ولفتح هذا الملف تحت ([PDF])علامة  

    (Acrobat Reader Program)  . 

من واجهة  (Image)حث عن الصور بكل سهولة وذلك باختيار صورة بيمكننا في كوكل ال -6

 الأختيار الرئيسية لكوكل .

 

       ----------------------------------------------------------------------------- 
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 رابــع الـى العاشـــــر :الأسبــوع ال 

 

Microsoft Excel : برنامج جداول بيانات يستخدم في تسجيل البيانات وتحليلها ومتابعة  هو 

 التغييرات التي تنجز على تلك البيانات وتعديلها بما يتلائم مع طبيعة                                      

 .Excelعية البيانات أو المعلومات التي يحتويها ملف أو نو                                    

 

 فيها :  Excelما هي أستخدامات وأبواب المعرفة التي يدخل 

 في كتابة التقارير المالية وأنشاء الموازنات وتحليل المعلومات    Excelيستخدم برنامج  -1

 ت وغيرها من المهام الأخرى أحصائيا" وذلك لأحتوائه على مميزات عديدة أهمها أجراء الحسابا     

 أوتوماتيكيا".    

 من أنشاء الرسوم أو المخططات البيانية التي توضح العلاقة بين  Excelيمكننا برنامج  -2

 المتغيرات كما يمكن أنشاء المخططات التنظيمية .    

 و التعديل .من استخدام الدوال البسيطة والمعقدة في أجراء الحسابات أ  Excelيمكننا برنامج  -3

 كبرنامج للطباعة أيضا" وذلك لأحتوائه على الكثير من الأوامر  Excelيمكن أستخدام برنامج  -4

 الخاصة  بالطبع وغيرها من المهام الأخرى .    

 

 هما : أماهناك طريقتان :  Microsoft Excelتشغيل برنامج 

  startقائمة البدء  من لا":وأ 

 

  Start → programs →  Microsoft offic → Microsoft Excel 

 

 

 أو 

 

 ثانيا" : 

     D.LC   on  icon Microsoft Excel       ( on the disktop) 
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 : Excelمحتويـــات نافــــذة           

  Microsoftويحتوي على جهة يساره على أسم البرنامج :  ( title Bar)شريط العنوان  -1           

               Excel  وعلى جهة اليمين لهذا الشريط الأزرار الثلاثة الخاصة بأغلاق البرنامج , تكبير وتصغير 

 النافذة وزر الأغلاق المؤقت .                

 هذا الشريط على مجموعة الأوامر الرئيسية الخاصة  ويحتوي( :  Menu Barشريط القوائم )  -  2       

  ,File, Edit, View, Insert, Format)وهي : Excelبالتعامل مع برنامج                 

              Tools , Data, Windows, Help ) . 

 أخفاؤها حسب  يحتوي على مجموعة من الأشرطة يتم أظهارها أو :(Tools Bar)شريط الأدوات  -3         

 الحاجة اليها مثل شريط الرسوم البيانية وشريط العمليات الحسابية وغيرها .             

 بأظهار أسم الخلية : يحتوي هذا الشريط على جزء خاص   ( Formula Bar )شريط الصيغ  -4         

 يانات والصيغ الرياضية والرموز ويلاحظ التي يتم التوقف عليها كما يحتوي على جزء خاص لأدخال الب              

 وجود الرموز التالية عند البدء بأدخال المعلومات :              

 أي أدخال المعلومة التي يتم طبعها وخزنها غي الخلية . Enter)   ( والتي تعني  –أ                

 لومة المطبوعة وعدم خزنها .أي حذف أو مسح المع Cancel( وهي بمعنى   X)  –ب                

 ) = ( يستخدم هذا الشكل عند كتابة الصيغ الرياضية المختلفة . –ج                

 : هي الجزء أو الحيز المخصص لطبع وخزن المعلومات عليه  ( Work Sheet)ورقـة العمـل  -5         

 تمثل جدولا" كبيرا" وتحتوي على أعمدة            حيث تحتوي هذه الورقة على مجموعة من التقاطعات               

 BAومن  Azالى  AAثم من  Zالى   Aوصفوف ) أسطر( وتسمى الأعمدة حسب الحروف من               

 عمود أما الصفوف فأن  (256)أي أن ورقة العمل تحتوي على  IVيسمى وآخر عمود  BZالى               

 صف أو سطر . (1634 )تحتوي على ورقة  العمل                

 من المهم أظهار هذا الشريط وذلك لكونه يظهر المعلومات   ( Status Bar)شريط الحالة  -6         

 بالأضافة الى  ةالخاصة بالأوامر أو الطريقة التي يتم بواسطتها أي يظهر شرح مبسط للأوامر المختار             

 يات الحسابية السريعة والتي سيتم شرحها  لاحقا" .أظهار بعض العمل             

 

 ويحتوي  (Work sheet)كتاب العمل  Excelسمى الملف الخاص بنظام ي1. مـلاحظــــة :           

 حيث يمكن أضافة عدد من أوراق العمل حسب Work sheetعلى أوراق العمل                           

 الحاجة اليها كما سيتم شلرحه لاحقا" .                            

 . xlsيمكن تسمية هذا الملف بأي أسم وتكون الأضافة الخاصة به  -2                           

 . (X)هي حرف  Excelتكون العلامة المميزة على رسم ملفات برنامج  30                           
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 (Row)أو سطر مع صف  (Column)هي الجزء المتكون من تقاطع عمود :  (Cell)الخليـة              

 في ورقة العمل .                                     

             

 هي الخلية التي يتم أختيارها حيث يظهر أسمها في شريط :   (Active Cell)الخلية النشطة             

 كون جاهزة للعمل عليها وتعديل والعمليات حيث ت الصيغ                                                             

 . محتوياتها                                                               

 :التاليتين يمكن تسمية الخلية بأحد الطريقتينتسميـة الخليـة :                

 .1والصف  Aأي العمود ِ A1تسمية الخلية بأسم العمود ثم رقم الصف مثلا" الخلية 1- 

 . Cوالعمود  3أي الصف  3Cتسمية الخلية أبتداءا" بالصف ثم العمود مثلا"  -2

 

 هو مجموعة من الخلايا المتجاورة أو غير المتجاورة يبدأ عنوان المدى بالخلية العليا بأقصى المـــدى :           

 الخلية الواقعة في الأسفل والى أقصى  وينتهي بعنوان (:)اليسار من المدى متبوعة بعلامة                          

 . (A1:D3)يمين المدى مثلا" ال                         
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 طـرق الأختيـار ) التظليـل( :           

 

 يتم أختيار خلية واحدة وذلك بالتوقف عليها بواسطة الماوس والنقر عليها بزر الماوسأختيار خلية :1-

 وذلك بالأنتقال من خلية الى   (Keybourd)بواسطة لوحة المفاتيح  الأيسر كما يمكن الأختيار     

 . Enterأخرى بواسطة الأسهم ثم الضغط على مفتاح       

 

 يتم ذلك كما يأتي :أختيار مجموعة خلايا متجاورة )المدى( : -2

 .Mouseالضغط على أول خلية ضمن المدى بواسطة ال  -أ  

 الأيسر وسحبه الى أن يصل الى آخر خلية ثم الضغط  Mouseالأستمرار بالضغط على زر ال  -ب 

 عليه مرة أخرى أي أنه يتم تحديد أول خلية وآخر خلية .      

 

 : Excelحدد أو ظلل كل مما يأتي في ورقة العمل لبرنامج تمرين عملي : 

 (A4 , R7 , AD9 , ZA1 , CX50 , T90 , DF77)الخلايا 1-

 {(D6:H16), (C5:G10) , (B1:D1) , (A1:A3 ) }المديات  -2

 

 أختيار عمود أو أختيار أوتظليل صف : -3

 يمكن أختيار عمود بالتوقف بيسار الماوس على أسم العمود وبنفس الطريقة يتم أختيار صف بالنقر      

 على رقم الصف بيسار الماوس .     

 : أختيار مناطق أو مديات غير متجاورة  -4

 او المدى الأول بالطرق المشروحة سابقا" .أختيار الخلية  –أ     

 من لوحة المفاتيح بشكل  (Ctrl)لأختيار الخلية الثانية أو المدى الثاني نقوم بالضغط على مفتاح  -ب    

 ئنا من تظليل أو تحديد كل المناطق أو الخلايا أو المديات الأخرى المطلوب امستمر لغاية أنته         

 . نلاحظ بقاء جميع الخلايا  (Ctrl)نفس ورقة العمل ثم نرفع يدنا من مفتاح ال تظليها   ضمن         

 والمديات الغير متجاورة مظللة بالرغم من عدم تجاورها .          

 

 :يتم تظليل ورقة العمل بأحد الطريقتين التاليتين :أو أختيار ورقة العمل  تظليل -5

 .Aوأسم العمود  1الفارغ المحصور بين رقم الصف  النقر بيسار الماوس على المربع -أ       

 .Aومفتاح الحرف  Ctrlباستخدام لوحة المفاتيح وذلك بالنقر وفي آن واحد على مفتاح  -ب       

 

 

 : للخروج من التظليل أو لألغاء التظليل لأي منطقة مظللة على ورقة العمل يتم ذلك بالنقر ملاحظة 

 عندما تكون كل ورقة ى أية خلية واقعة خارج منطقة التظليل بأستثناء بيسار الماوس عل             

 العمل هي المظللة  عندها ننقر بيسار الماوس على أي مكان للخروج من تظليل ورقة العمل              
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 : Excelج : ظلل مايأتي في ورقة العمل ببرنام تمرين عملي                  

 . Sثم العمود  Gثم العمود   Aالأعمدة 1- 

 . 20ثم  14ثم  3الصفوف  -2

 كل ورقة العمل .  -3

 ظلل المناطق التالية في آن واحد : -4

 . Hو  kوالأعمدة  20و  17و  15مع الصفوف  (A1:D1)مع المدى  B5الخلية   

 ل .وفي كل المطاليب أعلاه أخرج من التظليل بعد أن يتم التظلي

 

 

 ( Entering Data)أدخــال البيانـات فـي ورقـة العمـل  :

 

 لأدخال البيانات في ورقة العمل نتبع الخطوات التالية : 

 

 أنقر بيسار الماوس على الخلية المراد أدخال بيانات فيها أو أنقر على مفتاح الأدخال من لوحة 1- 

 د أدخال بيانات فيها بعد أن تم الأنتقال اليها بواسطة الأسهم .المفاتيح على الخلية المرا                       

 أدخل البيانات المراد أدخالها من خلال لوحة المفاتيح ) سواء أكانت هذه البيانات نصية أم رقمية  -2                  

 أم  صيغ رياضية (                         

 ( أما بالنقر على الرمز )       ( من شريط الصيغة أو  2دخلة في خطوة) ثبت هذه البيانات ال -3                  

 من لوحة المفاتيح . Enterبالنقر على مفتاح الأدخال                        

               ------------------------------------------------------------------------------------------ 

 

 أدخل البيانات التالية  في الخلايا المؤشرة أزاء كل منها :تمرين عملي :              

 

-1 A1 ← . التسلسل 

2- A2 ← 1 . 

3- A3 ← 2 . 

4- A4 ← 3 . 

5- B1 ← . أسم الطالب 

6- B2 ← . أزهار محمد 

7- B3 ← . وليد عدنان 

8- B4 ← . سمير حامد 
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 (  (Excel Worksheetورقـة عمــل  أكسل :                

 ويحتوي على أورق عمل  Excelعبارة عن ملف في برنامج  Bookالمصنف                    

                  Worksheet  وأوراق تخطيطChart Sheets  وتتكون أوراق العمل من 

 . Columnوالأعمدة  Rowsمجموعة من الصفوف                   

 

 

 .  Excelالقائمة وما تحتويه من أوامر تعمل في برنامج  : سندرس هذة File قائمـة

    

 يفتح لك البرنامج ورقة عمل جديدة تلقائيا"  Excel) جديد ( : عند فتح برنامج  newالأمر  1- 

 لبدء بأدخال بيانات أما أذا أردت أنشاء مصنف جديد فأتبع وما عليك سوى ا                              

 أحد الخطوات التالية :                                    

 وحسب الخطوات العملية التالية :       Fileمن قائمة  أما

File → New → general →Worksheet →ok                

       
  

 
 

 وذلك بالنقر بيسار الماوس على شكل الآيكونة :   Tools barمن شريط الأدوات   أو

 

 

  Excel: يستخدم هذا الأمر لفتح ملف مخزون  ) محفوظ ( مسبقا" في برنامج  openالأمر  -2

 ويتم ذلك بأحد الطريقتين أعلاه :            

 وحسب الخطوات العملية التالية : Fileمن قائمة  أما      

File → Open → L C on the name folder → Open           
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 وذلك بالنقر بيسار الماوس على شكل الآيكونة :   Tools barمن شريط الأدوات   أو

          

 

 ( (Book: يستخدم هذا الأمر لغرض أغلاق الملف أو المصنف ) أغلاق (  Closeالأمر  -3

 ويتم ذلك بأحد الطريقتين  مفتوحة , Excelمع بقاء واجهة برنامج                                          

 أمـــــاأدناه :                                           

 :  والخطوة العملية لذلك هي : Fileمن قائمة   - أ

File → Close                                                             

 أو 

 (X)النقر بيسار الماوس على الرمز  : والخطوة العملية لذلك :  Title Bar شريط العنوانمن  –ب 

 الخاص بنافذة المصنف أو الملف .                                                   

 

 نهائيا" ويتم   Excel)الخروج ( : يستخدم هذا الأمر للخروج أو لأغلاق برنامج  Exitالأمر  -4

 أمــــــا  ذلك بأحد الطريقتين التاليتين :                                       

 

  File → Exit والخطوة العملية لذلك ::  Fileمن قائمة  –أ                 

 

 والخطوة العملية لذلك :  النقر بيسار الماوس على الرمز  :   Title Barمن شريط العنوان  –ب    

                                                                (X) . الخاص بنافذة البرنامج الرئيسية 

 

                                                   

 

                                                                                

 يستخدم هذا الأمر لحفظ الملف أو المصنف بأسم جديد أنت فظ بأسم ( :) ح  Save Asالأمر  -5   

 ويتم ذلك بأحد  ( Book 1)تختاره  مغاير لأسم المصنف التلقائي                                     

 الطريقتين التاليتين :                                    

  ملية لذلك :والخطوة الع:   Fileمن قائمة  –أمـــــــــا  :  أ 
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File→Save As → Writ  the name file on squre file name→ 

Save   

 

 والطريقة العملية لذلك ::   (tools Bar)من شريط الأدوات  –أو   ب 

                                                                                                                                             

The name file on squre file name→Save               Writ →   

 

 

 ) حفظ( : ويستخدم لحفظ أو خزن بيانات جديدة أضيفت الى بيانات ملف مخزون  saveالأمر  -6        

  ثاني وثالث مرة  فأكثر لبيانات أضيفت مسبقا") يستخدم هذا الأمر للحفظ ل                                           

 مخزون مسبقا" ( ويتم ذلك بأستخدام أحد الطريقتيتن التاليتين :لبيانات ملف                                            

          File   :File → Saveمن قائمة  -أمـــــا : أ            

 : :  وذلك بالنقر بيسار الماوس على شكل الآيكونة Tools barت  من شريط الأدوا -أو      : ب            

                                                                                  

                                                                           . 

 

 :  Excelفي برنامج تمريـن  عمـلـي :نفذ ما يأتي        

 أدخل البيانات التالية والمتمثلة بأدخال  أربع تسلسلات تحت عنوان  -Excel  ,2أفتح برنامج 1- 

 خل أسماء أربعة طلاب في خلايا وأد A) تسلسل ( في خلايا العمود                                          

 ودرجاتهم في ثلاث مواد دراسية ) صحة مجتمع ,  Bمود  الع                                          

 على التوالي . ( C, D , E )حاسبات , دوائيات ( في الأعمدة                                           

 أحفظ البيانات السابقة بأسم ملف وليكن بأسم ) درجات طلابية ( . -3

 رجات طالب آخر ) خامس (  ودرجاته في المواد أضف أو أدخل بيانات جديدة بتسلسل وأسم ود -4

 أعلاه لبيانات الملف السابق .     

 ( الى الملف السابق (4أحفظ الأضافة الجديدة لبيانات الطالب الخامس التي أضفتها في فقرة  -5

 ) درجات طلابية ( .      

 .  Fileأغلق الملف ) درجات طلابية ( من قائمة  -6

 . Fileات طلابية ( من شريط الأدوات أو من قائمة أفتح الملف )درج -7

 أضف بيانات جديدة لطالب يحمل التسلسل السادس بكافة الحقول التي يحتاجها ثم أحفظ هذه الأضافة  -8

 على نفس الملف  ) درجات طلابية ( .    

 . Fileمن قائمة  Excelأغلق الملف ثم أغلق برنامج  -9

----------------------------------------------------------------------------------------- 

 ) طبع ( :يستخدم الأمر لطبع  البيانات المدخلة المراد طباعتها ) هذا في حالة كون  Printالأمر  -7

 الطابعة معرفة على الحاسبة ومربوطة بها كهربائيا" (   ويتم ذلك بأحد الطريقتين التاليتين :     
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      File   :File →Printمن قائمة  –أ أمـا :    

 

 : :  وذلك بالنقر بيسار الماوس على شكل الآيكونة Tools barمن شريط الأدوات   -ب           

                                                                                  
 

 

 عبارة عن برنامج للجداول الألكترونية , Excelبرنامج ( : ( Data Typeأنـواع البيـانات              

 ويستخدم ثلاثة أنواع من البيانات ) الرقمية , النصية , الصيغ                                                               

 الرياضية ( .                                                              

 

 أستخدام الصيغ الرياضية في تحليل البيانات : 

 تستخدم الصيغ الرياضية في تحليل الجداول الألكترونية                                                       

 والقيام بالعديد من العمليات الحسابية مما يوفر الوقت والجهد , أن العمليات الحسابية المستخدمة  في  

 ول الألكترونية هي :الجدا 

                  

 +       عملية الجمع                     

 عملية الطرح        -                     

 *      عملية الضرب                       

 /        عملية القسمة                      

 ( ^       الرفع الى أس ) القوة                     

 

 يجب وضع أشارة ) = ( دائما" قبل البدء بأدخال عملية حسابية للدلالة على القيام بعملية مـلاحـظـة : 

 .         حسابية                

 ثم أعمل على   بأدخال البيانات الرقمية في أدناه في الخلايا المؤشرة أزاء كل منها  قمتمـريـن عمـلـي :  

 تنفيذ العمليات الحسابية  التالية :                          

                    (A1=2 ,A2=5 , A3=20 , B1=4 , B2= 6 , B3=54 )  

 .A4واضعا" الناتج في الخلية   ( A1, A2 ,A3)أجمع محتوى الخلايا 1-

 .C3واضعا" الناتج في الخلية  B3على محتوى  A3قسم محتوى   -2

 . G1واضعا" الناتج في الخلية  A1محتوى  مع B2أضرب محتوى  -4

 ثم أرفعه للأس )محتوى  B1ثم قسم الناتج على محتوى  B2مع  A3أجمع  -5

 . A10( واضعا" الناتج في الخلية A1الخلية       

 

 

  (Sum Using Equation)أيجاد المجموع باستخدام معادلة المجموع :    

 س في الخلية المراد كتابة دالة المجموع فيها .نضع مؤشر الماو-1نتبع الخطوات التالية  :        

 أكتب أشارة )=( دلالة على كتابة صيغة رياضية . -2                                    

 متبوعة بأسم المدى الذي يحتوي على البيانات  Sumنكتب دالة  -3                                    
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 الرقمية المراد جمعها .                                        

 من لوحة المفاتيح . Enterنضغط على مفتاح الأدخال  -4                                    

                                   ------------------------------------------------------------- 

 

 لجمع البيانات الرقمية في  (C3:D5),(A1:A3)لمديات رقمية في ا خل بياناتدأتمرين عملي :     

 و  A5واضعا"ناتج الصيغة في الخلايا  (Sum)المديات أعلاه مستخدما" دالة المجموع                    

                   C5 . على التوالي 

 

 تبنك C5وفي الخلية    sum(A1:A3)=نكتب الصيغة الرياضية   A5في الخلية الحل :   

   sum(C3:D5)=الصيغة الرياضية                 

           -------------------------------------------------------------------------------- 

 : Auto Totalالجمع التلقائي  أيجاد المجموع باستخدام    

    

 مراد جمعها .نضع مؤشر الماوس في الخلية ال -1نتبع الخطوات التالية  : 

 من شريط الأدوات ننقر على آيكونة الجمع التلقائي  -2                             

                           Tools Bar  . سيظهر خط منقط حول الخلايا التي سيتم أيجاد المجموع لها 

 رمز الجمع التلقائي مرة أخرى ننقر على مفتاح الأدخال أو ننقر على  – 3                             

 لأيجاد ناتج الجمع التلقائي .                                    

 

 أن دالة الجمع التلقائي تستخدم لجمع البيانات الرقمية الواقعة على صف واحد أو عمود واحد ملاحظة : 

 ى نفس الصف أو العمود فأنها تظهر وتعمل مرة واحدة وعند أعادة أستخدامها مرة أخرى عل                  

                لذلك الصف أو ذلك العمود . نفس ناتج الجمع السابق ألا أذا أضفنا بيانات رقمية جديدة                   

                            

 

 تلقائيأستخدم دالة الجمع ال (C3:G3),(A1:A3)رقمية في المديات  خل بياناتدأتمرين عملي :  

  C3و  A4لجمع البيانات الرقمية في المديات أعلاه واضعا" ناتج الصيغة في الخلايا                    

 على التوالي .                   

 

                  ----------------------------------------------------------------------------------- 

 

 

 :(Funtion Wizard)جموع باستخدام معالج الدوال أيجاد الم     

 نضع مؤشر الماوس في الخلية المراد أيجاد ناتج الجمع فيها . -1نتبع الخطوات التالية  :      

 ننقر بيسار الماوس على آيكونة معالج الدوال الموجودة على شريط الصيغة.-2                                            

  Sumأنقر فوق  (Insert Function)من مربع الحوار الأول  -3                                            

 . OKمن قائمة أختيار الدوال ثم ننقر على مربع                                                   
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 . OKالمراد جمعها باستخدام معالج الدوال ثم ننقرعلى مربع انات الرقمية ينكتب المدى للب -4                      

                                               

                                   

                               
 

 

                         ------------------------------------------------------------------------------ 

                    / هناك طريقتان / الطريقة الأولى    (  (Minimum Valueحساب القيمة الصغرى                  

 لرياضية .نضع مؤشر الماوس في الخلية المراد كتابة الصيغة ا -1نتبع الخطوات التالية  :                

 دلالة على كتابة صيغة رياضية . نكتب أشارة )=( -2                                            

 متبوعة بأسم المدى المراد مقارنة بياناته  Minنكتب الصيغة الرياضية  -3                                            

 الرقمية لأيجاد أصغر قيمة عددية فيه .                                                 

 من لوحة المفاتيح لللحصول على ناتج   Enterننقر على مفتاح الأدخال  -4                                            
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 المقارنة .                                                

                                ----------------------------------------------------------------------------- 

 

 أكتب صيغة         (C3:G3),(A1:A3)رقمية في المديات  خل بياناتدأتمرين عملي :                           

 ذان المديان واضعا" الناتج رياضية صحيحة لأيجاد أصغر قيمة رقمية له                                             

 على التوالى : G6و  A5الخلايا في                                              

 ثم ننقر على  Min(A1:A3)=نكتب الصيغة الرياضية  A5الحل : في الخلية                                   

 . Enterمفتاح                                            

 ثم ننقر على  Min(C3:G3)=نكتب الصيغة الرياضية  G6في الخلية                                       

                                . Enterمفتاح                                            

                    ------------------------------------------------------------------------------------ 

 

 وكما يلي : Fx الطريقة الثانية : من معالج الدوال                        

 

 نضع مؤشر الماوس في الخلية المراد كتابة الصيغة الرياضية . -1نتبع الخطوات التالية  :                         

 ننقر بيسار الماوس على آيكونة معالج الدوال الموجودة على شريط  -2                                                      

 الصيغة.                                                          

  Minأنقر فوق  (Insert Function)من مربع الحوار الأول  -3                                            

 . OKمن قائمة أختيار الدوال ثم ننقر على مربع                                                   

                                                                           

                             
                   

 . OKالرقمية المراد جمعها باستخدام معالج الدوال ثم ننقرعلى مربع  اناتينكتب المدى للب -4                     
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 قا" باستخدام معالج الدوال أوجد أصغر قيمة رقمية للبانات الرقمية المدخلة مسبتمرين عملي :                      

 . A2, واضعا" الناتج في الخلية   (F1:G5)في المدى                                          

 ثم نتبع الخطوات العملية التالية : A2الحل : ننقر بيسار الماوس على الخلية                     

                                                   Fx→all→min→ok→(F1:G5)→ok 

 

                     ------------------------------------------------------------------------------------ 

 

 

                    / هناك طريقتان / الطريقة الأولى    (  (Maximum Valueحساب القيمة الكبرى                    

 نضع مؤشر الماوس في الخلية المراد كتابة الصيغة الرياضية . -1لتالية  : نتبع الخطوات ا               

 دلالة على كتابة صيغة رياضية . نكتب أشارة )=( -2                                            

 اد مقارنة بياناته متبوعة بأسم المدى المر Maxنكتب الصيغة الرياضية  -3                                            

 قيمة عددية فيه . الرقمية لأيجاد أكبر                                                 

 من لوحة المفاتيح لللحصول على ناتج   Enterننقر على مفتاح الأدخال  -4                                            

 المقارنة .                                                

                       

 أكتب صيغة         (B1:B3),(R4:R6)رقمية في المديات  خل بياناتدأتمرين عملي :               

 قيمة رقمية لهذان المديان واضعا" الناتج  رياضية صحيحة لأيجاد أكبر                                             

 : على التوالي G6و  A5في الخلايا                                              

                        

 ثم ننقر على  Max(B1:B3)=نكتب الصيغة الرياضية  A5الحل : في الخلية                       

 . Enterمفتاح                                            

 ثم ننقر على  Max(R4:R6)=نكتب الصيغة الرياضية  G6في الخلية                                       
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 .   Enterمفتاح                                            

                    -------------------------------------------------------------------------------------- 

 

 وكما يلي : Fx الطريقة الثانية : من معالج الدوال                        

 نضع مؤشر الماوس في الخلية المراد كتابة الصيغة الرياضية . -1نتبع الخطوات التالية  :                         

 الدوال الموجودة على شريط   ننقر بيسار الماوس على آيكونة معالج-2                                                      

 الصيغة.                                                          

  Maxأنقر فوق  (Insert Function)من مربع الحوار الأول  -3                                            

 . OKار الدوال ثم ننقر على مربع  من قائمة أختي                                                 

                            

 

 

 

 

 

                                

 . OKانات الرقمية المراد جمعها باستخدام معالج الدوال ثم ننقرعلى مربع ينكتب المدى للب -4                         
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 ثم أستخدم معالج الدوال  (B1:B3),رقمية في المدى  خل بياناتدأتمرين عملي :                                  

                              . B4 أكبر قيمة عددية في هذا المدى واضعا" الناتج في الخلية  لأيجاد                                                  

                        

 ثم  B4ننقر على الخلية  الحل :                         

                                                        Fx→all→max→ok→(B1:B3)→ok  

 

 

                    هناك طريقتان / الطريقة الأولى  :( Count ) حساب عدد الخلايا الرقمية                      

 نضع مؤشر الماوس في الخلية المراد كتابة الصيغة الرياضية . -1نتبع الخطوات التالية  :                 

 دلالة على كتابة صيغة رياضية . نكتب أشارة )=( -2                                            

 ة بأسم المدى المراد حساب متبوع Countنكتب الصيغة الرياضية -3                                            

 عدد خلاياه .                                                 

 عدد  لوحة المفاتيح للحصول على من  Enterننقر على مفتاح الأدخال  -4                                            

 . الخلايا                                                 

                                        ------------------------------------------------------------------- 

 

 أكتب صيغة         (C1:C5),(D1:F4)رقمية في المديات  خل بياناتدأتمرين عملي :                               

 رياضية  رقمية لحساب عدد الخلايا الرقمية لهذان المديان واضعا" الناتج                                              

 على التوالى : G6و  A5في الخلايا                                              

                        

 ثم ننقر على  Count(C1:C5)=نكتب الصيغة الرياضية  A5الحل : في الخلية                       

 . Enterمفتاح                                            

 ثم ننقر على  Count(D1:F4)=نكتب الصيغة الرياضية  G6في الخلية                                       

 .   Enterمفتاح                                            

                                       ---------------------------------------------------------------------- 
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 وكما يلي : Fx الطريقة الثانية : من معالج الدوال                       

                        

 نضع مؤشر الماوس في الخلية المراد كتابة الصيغة الرياضية . -1نتبع الخطوات التالية  :                         

                        

 ننقر بيسار الماوس على آيكونة معالج الدوال الموجودة على شريط  -2                                                    

 الصيغة.                                                          

                       

  Countأنقر فوق  (Insert Function)من مربع الحوار الأول  -3                                             

 . OKمن قائمة أختيار الدوال ثم ننقر على مربع                                                   

                                                       

                 

    

                            
                           

 . OKانات الرقمية المراد جمعها باستخدام معالج الدوال ثم ننقرعلى مربع ينكتب المدى للب -4                       
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                ------------------------------------------------------------------------------- 

 أستخدم معالج الدوال ثم  (A1:H10),رقمية في المدى  خل بياناتدأتمرين عملي :                                 

 .                              J1لحساب عدد الخلايا  في هذا المدى واضعا" الناتج في الخلية                                                   

                        

 ثم  J1الحل :     ننقر على الخلية                          

                                                        Fx→all→Count→ok→(A1:H10)→ok  

 

                                   

                    هناك طريقتان / الطريقة الأولى  :( Average ) حساب الوسط أو المعدل الحسابي              

 نضع مؤشر الماوس في الخلية المراد كتابة الصيغة الرياضية . -1نتبع الخطوات التالية  :                 

 دلالة على كتابة صيغة رياضية . نكتب أشارة )=( -2                                            

 متبوعة بأسم المدى المراد حساب Averageنكتب الصيغة الرياضية -3                                            

 المعدل الحسابي لها .                                                  

 من لوحة المفاتيح لللحصول على ناتج   Enterننقر على مفتاح الأدخال  -4                                            

 . الصيغة                                                

                                          ------------------------------------------------------------------ 

                              

 أكتب صيغة         (C1:C5),(D1:F4)رقمية في المديات  خل بياناتدأتمرين عملي :                               

 رياضية  رقمية لحساب الوسط الحسابي لهذان المديان واضعا" الناتج  في                                              

 على التوالى : G6و  A5الخلايا                                                

                        

 ثم ننقر على  Average(C1:C5)=نكتب الصيغة الرياضية  A5الحل : في الخلية                       

 . Enterمفتاح                                            

 ثم ننقر   Average(D1:F4)=نكتب الصيغة الرياضية  G6في الخلية                                       

 .   Enterعلى مفتاح                                             

                           ------------------------------------------------------------------------------ 

 وكما يلي : Fx الطريقة الثانية : من معالج الدوال                     

                        

 خلية المراد كتابة الصيغة الرياضية .نضع مؤشر الماوس في ال -1نتبع الخطوات التالية  :                         

                        

 ننقر بيسار الماوس على آيكونة معالج الدوال الموجودة على شريط  -2                                                    

 الصيغة.                                                          

                       

 أنقر فوق  (Insert Function)من مربع الحوار الأول  -3                                                   

      Average                                          من قائمة أختيار الدوال ثم ننقر على مربعOK . 
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 OKانات الرقمية المراد جمعها باستخدام معالج الدوال ثم ننقرعلى مربع ينكتب المدى للب -4                          

. 

                                                   

                               
                        

                          

 ثم أستخدم معالج الدوال  (A1:H10),رقمية في المدى  خل بياناتدأتمرين عملي :                                    

 لحساب  المعدل أو الوسط الحسابي لهذا المدى واضعا" الناتج في الخلية                                                   

                                                   J1          .                     

                        

 ثم  J1الحل :     ننقر على الخلية                                            

 

                                                        Fx→all→Average→ok→(A1:H10)→ok  
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 ( : Wrong Formulaتنتج قيم خطأ ) الصيغ التي            

 

 ولا  تظهر قيم الخطأ مبدوءة بعلامة )#( Excelفة لما يتوقعه معينة مخالقيم  خالعند أد       

 يستطيع حساب الصيغة بالصورة الصحيحة , وأمثلتها :       

  Name#قادر على التعرف عليها                رأسماء غي            

       Null#عيين تقاطع للمصفوقتين غير صالح          ت            

          NIA#صيغة غير متاحة                                          

                 #####العمود ضيق                                    

     Value#           لا يستطيع تحويل النص الى أرقام              

                     

                     ------------------------------------------------------------------------------- 

 

  

 .  Excel سندرس هذة القائمة وما تحتويه من أوامر تعمل في برنامج  ) تحرير (: Editقائمـــة                   

                  

 )قص أو نقل أو تحريك ( : لنقل  بيانات  الخلايا من مكان الى آخر على نفس وقة  Cutـر الأم1- 

 العمل ) سواء أكانت بيانات خلية واحدة أو بيانات مدى معين أو بيانات عمود او صف ( أو نقل      

 ان ما على ورقة البيانات من مكان ما على ورقة العمل الحالية ) التي تدخل بياناتك عليها ( الى مك     

 (التالية  :أحد الطرق الثلاثعمل أخرى  تحدد لك حسب مطلوب السؤال عندها نتبع )      

        

 عندها نتبع الخطوات العملية التالية : :  Editمــن قائمـة  : أولا"  أمــــا  

 حدة أو مدى معين أونحدد أو نظلل بيانات الخلايا المراد قصها أو نقلها ) سواء أكانت خلية وا -1   

 أكمله أو صف بأكمله أو ورقة العمل بأكملها ( حسب ما مطلوب نقله في السؤال .عمود ب              

 . Menu Barائم الرئيسي ومن شريط الق Editننقر بيسار الماوس على قائمة  – 2         

 ستلاحظ )بيسار الماوس Cutالأمر  (2)ذ خطوة التي ستفتح بعد تنفي  Editنختار من قائمة  -3                    

 تحت أمر  )ستأطر بأطار منقط دلالة على أنها (1)أن البيانات التي ظللت أو حددت في الخطوة                         

 . (القص أو النقل                        

 داية مكان اللصق )الذي سيتم لصق البيانات المنقولةننقر بيسار الماوس على الخلية التي تمثل ب -4                    

 (. االيه                         

 مرة أخرى . Editننقر على قائمة  – 5                    

 أن البيانات بيسار الماوس , عندها ستلاحظ  )لصق( Pastالأمر  Editنختار من قائمة  -6                    

 ستنقل الى المكان الجديد الذي لصقت عليه مع عدم بقاء نسختها الأصلية في مكانها  الأول الذي                         

 كانت فيه قبل القص أو النقل .                         

    

                    ------------------------------------------------------------------------------------- 
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 والمنزل أمامك في أدناه : حفوظ بأسم ) درجات طلابية ( مأفتح ملفك المخزون أو التمرين عملي :                  

                

                                             

 
 

 خال درجات لها د( دون أأعمل أولا" على أدخال تسلسل طالب جديد وليكن أسمه ) مريم هادي                     

                

 ثم  (مريم)( وأجعلها للطالبة  ) سهىنقل درجات الطالبةأ  Editوالمطلوب وباستخدام قائمة                 

 أو شرط الأدوات  : Fileأحفظ هذه التعديلات باستخدام أما قائمة                     

بأسم الطالبة )مريم هادي ( نعمل على تطبيق الخطوة العملية التالية    (4)رقم  خال تسلسلدالحل : بعد أ              

: 

                       

                       Edit ←Cut ←L C on C5 ← Edit ←past← (C3:E3)نظلل                       

                                                    LC      LC                                  LC        LC 

 عندها سنلاحظ عمليا" ناتج الخطوة العملية أعلاه على ورقة العمل ضمن هذا الملف وكما في أدناه ثم             

 من شريط   LC on Icon أو     File →Saveننفذ الخطوة العملية المطلوبة في السؤال              

 لأدوات .ا             

 

 

 

 ) لاحــظ ناتج تنفيذ أيعاز القص أو النقل كما في الشكل أدناه  :(                                
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                      -------------------------------------------------------------------------------------- 

 

 (:(Minu Barأو ثـانيـا" :  نقل أو قص البيانات باستخدام شريط الأدوات                     

 طريقة العمل :                                 

  

 نحدد أو نظلل بيانات الخلايا المراد قصها أو نقلها ) سواء أكانت خلية واحدة أو مدى معين أو -1      

 أكمله أو ورقة العمل بأكملها ( حسب ما مطلوب نقله في السؤال .عمود بأكمله أو صف ب                      

 )ستلاحظ أن البيانات التي ظللت أو  ,من شريط الأدوات   ننقر بيسار الماوس على الآيكونة  -2               

 ( .ستأطر بأطار منقط دلالة على أنها تحت أمرالقص أو النقل (1)حددت في الخطوة                      

 ننقر بيسار الماوس على الخلية التي تمثل بداية مكان اللصق )الذي سيتم لصق البيانات المنقولة -3               

 اليها (.                         

                 

 عندها ستلاحظ أن البيانات  من شريط الأدوات , ننقر بيسار الماوس على الآيكونة  -4               

 ستنقل الى المكان الجديد الذي لصقت عليه مع عدم بقاء نسختها الأصلية في مكانها  الأول الذي                         

 كانت فيه قبل القص أو النقل .                         

                          -------------------------------------------------------------------------- 

 ( الى الطالبة  ة ) سهىنفس التمرين العملي السابق أعمل على قص بيانات الطالب تمرين عملي :                  

 ) مريم ( ولكن بأستخدام شريط الأدوات :                                     

 الحل :                   

 Lc on  ← L C on C5←   Lc on← (C3:E3)نظلل                              

 

 عندها سنلاحظ ناتج تنفيذ هذه الخطوة العملية كما في الناتج الذي حصلنا عليه في التمرين السابق:                    
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 أو ثـالثـا" :  نقل أو قص البيانات باستخدام فعالية يمين الماوس:                    

 طريقة العمل :                                 

 

 نحدد أو نظلل بيانات الخلايا المراد قصها أو نقلها ) سواء أكانت خلية واحدة أو مدى معين أو -1          

 عمود بأكمله أو صف بأكمله أو ورقة العمل بأكملها ( حسب ما مطلوب نقله في السؤال .                      

 ستفتح قائمة أوامر . (1)بيمين الماوس على أية خلية محددة أو مظللة في خطوة ننقر  -2                   

 )ستلاحظ أن البيانات التي ظللت أو حددت في الخطوة  ( من قائمة الأوامر ,(Cutنختار الأمر  -3                  

 نقل( .ستأطر بأطار منقط دلالة على أنها تحت أمرالقص أو ال (1)                       

 ننقر بيسار الماوس على الخلية التي تمثل بداية مكان اللصق )الذي سيتم لصق البيانات المنقولة -4                  

 اليها (.                         

                 

 مر .ستفتح قائمة أوا (4)ننقر بيمين الماوس على الخلية التي حددت في خطوة  -5                   

 عندها ستلاحظ أن البيانات ستنقل الى المكان الجديد الذي لصقت عليه  , Pastنختار الأمر  – 6                   

 مع عدم بقاء نسختها الأصلية في مكانها  الأول الذي كانت فيه قبل القص أو النقل .                          

 

                         --------------------------------------------------------------------------- 

                 

 ( الى الطالبة  ة ) سهىنفس التمرين العملي السابق أعمل على قص بيانات الطالب تمرين عملي :                

 ) مريم ( ولكن بأستخدام فعلية الماوس                                     

 الحل :                          

  RC on any cells on(C2:E2) ←Cut←Rc On C5 ← (C2:E2)نظلل              

                      ←past  , 

 

                  

 بق:عندها سنلاحظ ناتج تنفيذ هذه الخطوة العملية كما في الناتج الذي حصلنا عليه في التمرين السا                 

             --------------------------------------------------------------------------------------------- 

 

 لنسخ  بيانات  الخلايا من مكان الى آخر على نفس وقة  )نسخ(: Copyالأمر  -2           

  ت عمود او صف ( أو نسخأو بياناالعمل ) سواء أكانت بيانات خلية واحدة أو بيانات مدى معين      

 البيانات من مكان ما على ورقة العمل الحالية ) التي تدخل بياناتك عليها ( الى مكان ما على ورقة      

 (التالية  :أحد الطرق الثلاثعمل أخرى  تحدد لك حسب مطلوب السؤال عندها نتبع )      

        

 عندها نتبع الخطوات العملية التالية : :  Edit: مــن قائمـة  أولا"  أمــــا  
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 نحدد أو نظلل بيانات الخلايا المراد نسخها ) سواء أكانت خلية واحدة أو مدى معين أو -1

 عمود بأكمله أو صف بأكمله أو ورقة العمل بأكملها ( حسب ما مطلوب نسخه في السؤال .              

 . Menu Barمن شريط القوائم الرئيسي  Editئمة ننقر بيسار الماوس على قا – 2         

        Copyالأمر  (2)التي ستفتح بعد تنفيذ خطوة   Editنختار من قائمة  -3                    

 ستأطر بأطار منقط  (1)بيسارالماوس)ستلاحظ أن البيانات التي ظللت أو حددت في الخطوة                          

 دلالة على أنها تحت أمر  النسخ( .                         

 ننقر بيسار الماوس على الخلية التي تمثل بداية مكان اللصق )الذي سيتم لصق البيانات   -4                    

 المنسوخة اليها (.                         

 مرة أخرى . Editننقر على قائمة  – 5                    

 )لصق( بيسار الماوس , عندها ستلاحظ أن البيانات  Pastالأمر  Editنختار من قائمة  -6                    

 بقاء نسختها الأصلية في مكانها  الأول الذي كان الجديد الذي لصقت عليه مع الى الم ستنسخ                         

 . سخاء عملية النركانت فيه قبل  اج                         

                   -------------------------------------------------------------------------------------- 

 والمنزل      حفوظ بأسم ) درجات طلابية ( مأفتح ملفك المخزون أو التمرين عملي :                      

 أمامك في أدناه :                          

                

                                             

 
 

 خال درجات لها دأعمل أولا" على أدخال تسلسل طالب جديد وليكن أسمه ) مريم هادي ( دون أ                  

 لب) أحمد ( وأجعلها للطالبة مريم ثم ادرجات الط نسخأ  Editوالمطلوب وباستخدام قائمة                     

 أو شرط الأدوات  : Fileأحفظ هذه التعديلات باستخدام أما قائمة                     

بأسم الطالبة )مريم هادي ( نعمل على تطبيق الخطوة العملية التالية    (4)خال تسلسل رقم دالحل : بعد أ              

: 
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                       Edit ←Copy ←L C on C5 ← Edit ←past← (C2:E2)نظلل                       

                                                    LC      LC                                  LC        LC 

 ه على ورقة العمل ضمن هذا الملف وكما في أدناه ثمعندها سنلاحظ عمليا" ناتج الخطوة العملية أعلا             

 من شريط   LC on Icon أو     File →Saveننفذ الخطوة العملية المطلوبة في السؤال              

 الأدوات .             

 

 كما في الشكل أدناه  :( ظ ناتج تنفيذ أيعاز النسخ) لاحــ                       

            

 

 
 

 ) لاحظ أن درجات الطالب أحمد قد نسخت كدرجات للطالبة مريم مع بقاء درجات الطالب احمد                    

 في مكانها الأصلي (                       

                 --------------------------------------------------------------------------------------- 

            

 مــلاحظـــــة:                             

 أن أيعازالقص ينقل البيانات  Copyعن أيعاز النسخ  Cut أن فرق أيعاز القص 1-                            

 مكانها مع عدم بقاء نسخة لتلك البيانات في المقصوصة أو المنقولة الى المكان الجديد                                

 الذي نسخت اليه  عمل نسخة للبيانات في مكانها الجديدالأصلي بينما أمر النسخ يعمل على                                

 انات في مكانها الأصلي .يمع ترك أو بفاء النسخة الأصلية للب                               

 من لصق البيانات الى ل لمرة واحدة فقط أما أمر النسخ الواحد يمكننا أن أمر القص يعم -2                           

 عدد غير منتهي  من المرات ألا أذا أنهينا عمل أمر النسخ وكما سيأتي في الملاحظة                                 

 . التالية                                 

 )الهروب أو الخروج(   (Esc)اء عمل أمر النسخ وذلك بالنقر على مفتاح يتم أنه-3                            

 الموجود في أقصى أعلى  يسار لوحة المفاتيح .                                

                    ------------------------------------------------------------------------------------------ 
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 (:(Minu Barالبيانات باستخدام شريط الأدوات   ثـانيـا" :  نسخ أو                     

 طريقة العمل :                                 

 نحدد أو نظلل بيانات الخلايا المراد نسخها ) سواء أكانت خلية واحدة أو مدى معين أو -1                    

 عمود بأكمله أو صف بأكمله أو ورقة العمل بأكملها ( حسب ما مطلوب نسخه في السؤال.                      

                   

 )ستلاحظ أن البيانات التي     )نسخ( من شريط الأدوات , ننقر بيسار الماوس على الآيكونة   -2                      

 ستأطر بأطار منقط دلالة على أنها تحت أمرالنسخ( . (1)ت في الخطوة ظللت أو حدد                           

 ننقر بيسار الماوس على الخلية التي تمثل بداية مكان اللصق )الذي سيتم لصق البيانات  -3                    

 المنسوخة اليها (.                        

 عندها ستلاحظ أن البيانات  من شريط الأدوات , ونة ننقر بيسار الماوس على الآيك -4                

 ستنسخ الى المكان الجديد الذي لصقت عليه مع  بقاء نسختها الأصلية في مكانها  الأول الذي                         

 كانت فيه قبل النسخ .                         

                          --------------------------------------------------------------------------                                  

 نفس التمرين العملي السابق أعمل على نسخ بيانات الطالب ) أحمد ( الى الطالبة  تمرين عملي :                        

 شريط الأدوات :) مريم ( ولكن بأستخدام                                      

 الحل :                   

Lc on← (C2:E2)نظلل                                 ← L C on C5←   Lc on 

 

 عندها سنلاحظ ناتج تنفيذ هذه الخطوة العملية كما في الناتج الذي حصلنا عليه في التمرين السابق:                    

 

 

                          ----------------------------------------------------------------------------- 

 

 

 

 البيانات باستخدام فعالية يمين الماوس: أو ثـالثـا" :  نسخ                                

 طريقة العمل :                                 

 

 نسخها ) سواء أكانت خلية واحدة أو مدى معين أو ا المراد نظلل بيانات الخلاي نحدد أو -1          

 عمود بأكمله أو صف بأكمله أو ورقة العمل بأكملها ( حسب ما مطلوب نسخه في السؤال .                      

 ستفتح قائمة أوامر . (1)ننقر بيمين الماوس على أية خلية محددة أو مظللة في خطوة  -2                   

 )ستلاحظ أن البيانات التي ظللت أو حددت في  ( من قائمة الأوامر ,(Copyنختار الأمر  -3                  

 ستأطر بأطار منقط دلالة على أنها تحت أمرالنسخ( . (1)الخطوة                       

 صق )الذي سيتم لصق البيانات المنسوخةننقر بيسار الماوس على الخلية التي تمثل بداية مكان الل -4                  

 اليها (.                         
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 ستفتح قائمة أوامر . (4)ننقر بيمين الماوس على الخلية التي حددت في خطوة  -5                   

 المكان الجديد الذي لصقت عليه  عندها ستلاحظ أن البيانات ستنسخ الى , Pastنختار الأمر  – 6                   

 مع  بقاء نسختها الأصلية في مكانها  الأول  .                          

                    ------------------------------------------------------------------------------------ 

 

 ملي السابق أعمل على نسخ بيانات الطالب ) أحمد ( الى الطالبة نفس التمرين الع تمرين عملي :                     

 ) مريم ( ولكن بأستخدام فعلية الماوس                                     

 الحل :                          

  RC on any cells on(C2:E2) ←Copy←Rc On C5 ← (C2:E2)نظلل              

                      ←past  , 

 

                  

 عندها سنلاحظ ناتج تنفيذ هذه الخطوة العملية كما في الناتج الذي حصلنا عليه في التمرين السابق)أي                 

 ستنسخ درجات الطالب أحمد للطالبة مريم مع بقاء درجات الطالب أحمد في مكانها (                  

 

                     ---------------------------------------------------------------------------------    

 

 

 

 

 

 

 

 

 

 

 

 

 والمدخلة فيه البيانات التالية :  Excelلديك الملف التالي في برنامج تمرين عملي :                     
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 ل على تنفيذ ما يأتي : والمطلوب أعم                

 فعالية الماوس .أنسخ بيانات المريض)  كامل ( للمريضة )هبة( مستخدما" 1-

 ( وبأسم ) فاطمة محمد ( . 4أدخل بيانات كاملة لمريض يحمل التسلسل ) 2-

 أنقل بيانات المريض ) وائل ( الى المريضة ) فاطمة ( مستخدما" شريط الأدوات . -3

 .Editأنسخ بيانات المريضة )  فاطمة ( الى المريض ) وائل ( مستخدما" قائمة  -4                  

 . Fileأحفظ كل البيانات السابقة بأسم ملف يحمل أسم ) بيانات مرضى ( مستخدما" قائمة  -5                  

 يط الأدوات .رمستخدما" ش 2( ورقة (Sheet2الى  1ورقة  (sheet1)أنسخ بيانات  -6                  

 الى الصف العاشر  (sheet1)في الورقة الأولى  (Row1)أنقل بيانات الصف الأول  -7                  

                         (Row10)  مستخدما" قائمة .Edit . 

 مستخدما" فعالية يمين الماوس . Sheet3الى  Sheet2أنقل بيانات  -8                  

 مستخدما" شريط الأدوات .  Fالى العمود  Cأنسخ بيانات العمود  -9                  

 .Editقائمة مستخدما"  H1الى الخلية  A4قص بيانات الخلية  -10                  

 أحفظ التعديلات السابقة على نفس الملف مستخدما" شريط الأدوات . -11                   

 . Fileق الملف )بيانات مرضى ( من قائمة أغل -12                   

 . Fileمن قائمة  Excelأغلق برنامج  -13                   

 

             ---------------------------------------------------------------------------------------------- 

 

 

  أن هذا الأمر من أوامرأو نسخ ورقة العمل : نقل  (Move or copy sheet)الأمر  -3               

 حيث يعمل هذا الأمر على تنفيذ أمرين يخص أوراق العمل الموجودة على  شريط  Editقائمة                      
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 الأوراق من ناحية أما نسخها أو نقلها على شريط الأوراق  وطريقة العمل تتم بأحد الطريقتين                    

 ويتم ذلك كما يلي : Editمن قئمة   أمــــــاالتاليتين :                     

 نحدد أي ننقر بيسار الماوس على أسم ورقة العمل المراد نقلها أو نسخها على شريط الأوراق 1- 

 من شريط القوائم , ستفتح قائمة الأوامر الخاصة بهذه القائمة . Editننقر على قائمة  -2

 ( بيسار الماوس , سيفتح مربع حوار كما في (Move or copy sheetنختار الأمر  -3                      

 أدناه :                           

                                     
 خطوة  ننقر بيسار الماوس )قبل أي ورقة عمل يراد عمل نسخة أو نقل ورقة العمل المحددة في -4                    

                                        (1)                  

 

 في حالة يراد نقل الورقة وألا ننقر بيسار الماوس ) أي نفعل ( المربع (OK)على مربع  ننقر -5                   

   في حالة  (OK)مربع ثم ننقر على  (أنشاء نسخة)  (Create sheet)المجاور لعبارة                         

 الأوراق . لورقة العمل على شريط  هذا الأختيار سيتم عمل نسخة ثانية                        
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  يتم من خلاله عملنقل أو نسخ ورقة ال ( Move or copy sheet)أن أمر مــــلاحظـة :                   

 نقل أو نسخ أوراق العمل على شريط الأوراق بغض النظر عن كون ورقة العمل                                   

 تحتوي على بيانات أو خالية من البيانات .                                  

                       ----------------------------------------------------------------------------- 

 

 )نقل أو نسخ ورقة العمل باستخدام فعالية الماوس ( : طريقة العمل كالتالي :أو                 

                 

 نحدد أي ننقر بيسار الماوس على أسم ورقة العمل المراد نقلها أو نسخها على شريط الأوراق 1-

 . (1)على الورقة التي حددت في خطوة  سننقر بيمين الماو -2 

 الأمر نقل أو نسخ ورقة  2))  نختار من قائمة الأوامر التي ستفتح بعد تنفيذ خطوة -3                 

                       (Move or copy sheet )  : كما مبين في أدناه 

       

 

                 

 

 فتح مربع الحوار التالي لتفعيل أما أمر النسخ أو أمر النقل للورقة المحددة :عندها سي                     

 أمــــا : نقل                        
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 أو أمر تفعيل أنشاء نسخة : 

 

                       
 

  

                                   ----------------------------------------------------------------- 

 

 الى نهاية شريط الأوراق لبرنامج  (Sheet1) 1أعمل على نسخ ورقة  تمرين عملي :                      

                                          Excel   3ثم أنقل ورقة (sheet3)  1الى بداية الشريط أي قبل ورقة 

 للمطلوب رالأول وفعالية الماوس   Editمستخدما" قائمة  على شريط الأوراق                                         

 للمطلوب الثاني :                                         

 الى نهاية شريط الأوراق : 1لنسخ ورقة  الحــــل :                     
                           Ok→ Sheet1→Edit→Move or copy sheet→Move to End→Creat acopy 

       LC         LC             L C                           LC                  LC                LC                     

 

 : 1الى ما قبل ورقة  3لنقل أو قص ورقة                                  
                                             Ok→ Sheet3→mous→Move or copy sheet→sheet1→ 

                                                          LC         RC             L C                           LC           LC 

 --------------------------------------------------------------------------------- 
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 والتي مر  يستخدم هذا الأمر للصق البيانات المنسوخة أو المنقولة )لصق (  Pastالأمر  -4                       

 .  Edit في قائمة شرحها مسبقا"                            

                          -------------------------------------------------------------------------------- 

 حيث يتم تنظيف  Editعلى قائمة يوجد هذا الأمر  )تنظيف أو مسح ( :Clearالأمر  -5                       

 ة تتم كما يأتي :أو مسح البيانات مع بقاء الخلايا فارغة في أماكنها  والطريقة العملي                             

 نحدد أو نظلل الخلايا المراد تنظيف أو مسح بياناتها ) سواء أكانت خلية أو مدى معين أو  -1                        

 صف أو عمود أو ورقة العمل بأكملها ( .                             

 سار الماوس , ستفتح قائمة الأوامر .من شريط القوائم بي Editنفتح قائمة  -2                         

 , ستلاحظ أن بيانات  allثم نختار الأمر  ) مسح ( بيسار الماوسClearنختار الأمر -3                          

 قد مسحت مع بقاء أماكن الخلايا فارغة في أماكنها . (1)خطوة المنطقة التي حددت في                              

                     

 لذلك كما يأتي :لتنفيذ أمر المسح وهي فعالية يمين الماوس والطريقة العملية  هناك طريقة ثاتية                      

                

 نحدد أو نظلل الخلايا المراد تنظيف أو مسح بياناتها ) سواء أكانت خلية أو مدى معين أو  -1                    

 صف أو عمود أو ورقة العمل بأكملها ( .                             

 ,ستفتج قائمة  (1)ننقر بيمين الماوس على أي جزء من المنطقة المحددة أو المظللة في خطوة  -2                     

 أوامر .                          

 , ستلاحظ أن بيانات )مسح المحتويات Clear Contentsنختار من القائمة الأمر  -3                      

 قد مسحت مع بقاء أماكن الخلايا فارغة في أماكنها . (1)المنطقة التي حددت في خطوة                           

 

                      ------------------------------------------------------------------------------------- 

         

 أدخل بيانات رقمية أو نصية في الخلايا والمديات والصفوف والأعمدة التالية ثم أعمل عملي : ن ـتمري               

 وأخرى  Editت على التوالي  مستخدما" مرة قائمة تلك البيانا مسح أو تنظيفعلى                                   

 فعالية يمين الماوس :                                   

  A1,D3,H7,J10الخلايــــــــــــا :                               

 (w2:W21),(F4:F7),(B1:B3):  المديــــــــــات                               

  Row3 , Row9الصفــــــــوف :                                

 Column C , Column Kالأعمـــــــــــدة  :                               

 

                 ----------------------------------------------------------------------------------------- 

 )حذف ( : أن أمر الحذف هذا يمكننا من حذف صفوف وأعمدة بأكملها  Deleteالأمـر  -6                  

 فيتم أزالتها من ورقة العمل وأنتقال الخلايا المحيطة لتعبئة الفراغ :                                                           

 : (Delete)وهناك طريقتان للوصول الى تنفيذ أمر الحذف                        

 ذ ذلك كما يأتي :يوالطريقة العملية لتنف:  Editالأولــــــــــــى : من قائمـة                         

  أولا" : كيف يتم حذف البيانات المدخلة في الصفوف  :سنتعرف                         
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 نحدد أو نظلل الصف المراد حذف بياناته )وذلك بالنقر على رقم الصف ( . -1                       

 , ستلاحظ أن بيانات ذلك الصف ستحذف  Editمن قائمة  Deleteننقر على الأمر  -2                       

 وتعبأ بيانات الصف الذي يليه الى ذلك الصف الذي حذفت بياناته .                           

                           

     حذف البيانات المدخلة في الأعمدة :: ثانيـــا"                              

 نحدد أو نظلل العمود المراد حذف بياناته )وذلك بالنقر على أسم العمود ( . -1                           

 , ستلاحظ أن بيانات ذلك العمود ستحذف  Editمن قائمة  Deleteننقر على الأمر  -2                           

 الذي حذفت بياناته . يه الى ذلك العمودبيانات العمود الذي يلوتعبأ                                 

                     ------------------------------------------------------------------------------------ 

 :أدخل بيانات رقمية في الأعمدة والصفوف التالية تمرين عملي :                  

                                      (  4 , 3 , 2 , 1)والصفوف  ( A ,B , C , D)مدة الأع                               

  (2,3)ثم أحذف بيانات الصفوف  ( B , C)ثم أعمل على حذف بيانات الأعمدة                               

 . Editمستخدما" قائمة                                

                                ------------------------------------------------------------------------- 

 حذف البيانات المدخلة الى الخلايــا : رابعــا" :                           

 تلك الخلية   قر بيسار الماوس علىنحدد أو نظلل الخلية المراد حذف بياناتها وذلك بالن -1                         

 التالي : Deleteحوارسيفتح مربع  ,  Editمن قائمة  Deleteننقر على الأمر  -2                         

                                              

                                           

                                                                
                           

 

 حيث يحتوي مربع الحوار هذا على أربعة خيارات تختار من خلالها طريقة الحذف المطلوب تنفيذها                   

 ) أزاحة الخلايا لليسار( . Shift cells left -1وهي :                    

                            2-Shift cells up . ) أزاحة الخلايا للأعلى ( 

                            3- Entire Row  . الصف بأكمله ( , أي أزاحة الصف الذي تقع عليه تلك الخلية ( 

                            4-Entire Column . العمود بأكمله ( أي حذف العمود الذي تقع عليه تللك الخلية ( 

 بيسار الماوس .  OKوفي حالة أختيار أي من الخيارات أعلاه ننقر أخيرا" على مربع                                

                        --------------------------------------------------------------------------------------- 
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 وهي : Deleteفيذ أمـر الحذف الطريقــة الثانــيـة : لتن                           

 وطرقة العمل كالتالي : طريقــة فعاليـة يميـن المـاوس :                           

 . نحدد أو نظلل بيانات الخلية المراد حذفها  -1                          

 , عندها ستفتح قائمة أوامر أختر  (1)ننقر بيمين الماوس على الخلية المحددة في خطوة  -2                          

 . Deleteمنها الأمر )حذف(                                

 ستلاحظ مايأتي : أولا": أذا حذف صف بأكمله ستزاح وتنتقل بيانات الصف الذي يليه بدل                      

 صف التي حذفت  .بيانات ال                                                     

 أو             ثـانيـــــا: أذاحذفت عمود بأكمله ستنتقل بيانات العمود الذي يليه بدل بيانات                          

 العمود التي حذفت .                                                      

 عندها  (Delete): أذا حذفت خلية سيظهر لك مربع حوار حذف أو           ثـالثـــــا"                          

 ستختار أحد الخيارات الأربعة حسب ما مطلوب حذفه .                                                      

                        ----------------------------------------------------------------------------------- 

 

 :أدخل بيانات رقمية في الأعمدة والصفوف التالية تمرين عملي :                                     

                                      (  4 , 3 , 2 , 1)والصفوف  ( A ,B , C , D)الأعمدة                                

  (2,3)ثم أحذف بيانات الصفوف  ( B , C)م أعمل على حذف بيانات الأعمدةث                               

 (A3,A4,A5مستخدما" فعالية يمين الماوس ثم أدخل بيانات رقمية في الخلايا                                

                                                               (B3,B4,B5,C3,C4,C5 

  B4ثم أحذف الصف الواقعة عله الخلية                                

 B4ثم أحذف العمود الواقعة عليه الخلية                                

                             ------------------------------------------------------------------------------- 

 : ( Delete Sheet)حذف ورقة العمل الأمر  -7               

               شريط الأوراقلحذف وألغاء ورقة العمل سواء أكانت تحتوي على بيانات أو خالية من البيانات من                    

 نتبع أحد الطريقتين التاليتين : Exeleالموجود أسفل ورقة العمل في برنامج                    

 نتبع الخطوات العملية التالية ::  Editأولا" : من قائمة                   

 . ) من شريط الأوراق ( على ورقة العمل المراد حذفها نحدد أو ننقر بيسار الماوس -1                    

 هية مفادها, عندها ستظهر لك رسالة تنبي Editمن قائمة  Delete Sheetنختار الأمر  -2                    

 أنه ستم حذف ورقة العمل وما تحتويه من بيانات فأذا رغبت بالحذف أنقر على مربع                           

                         Delete  وألا أنقر على مربعCancel : وشكل الرسالة كالتالي. 
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 في حالة كون الورقة التي تريد حذفها من على شريط الأوراق خالية من البيانات فأن عملية  1-ملاحظة :          

 سالة التنبيهية .حذف الورقة  سيتم بدون أن تظهر لك هذه الر                           

 واحدة بعد الأخرى  الأوراق واحدة على شريط الأوراق بعد حذف عمل في حالة بقاء ورقة - 2

 رفضا" من خلال رسالة مفادها أنه لايمكن  Excelهذه الحالة يعطيك برنامج  ففي       

 على  حذف ورقة العمل هذه وذلك لأنه على الأقل يجب بقاء ورقة عمل واحدة أفتراضية       

 شريط الأوراق والرسالة هي كالتالي :       

                              

 
 

  هي أحدى القوائم الموجودة في شريط القوائم الرئيسي لبرنامج:  (Insert)قائمـــــــة أدراج                  

                                                     Excel : هذه القائمة الأوامر التالية :وسنأخذ من 

 حيث يتم أدراج صف جديد خالي من البيانات قبل الصف الذي )صفوف (:  Rowsالأمر 1-

 وكما يلي : Excelحدد أو ظلل مسبقا" في ورقة عمل                                         

                     

 مراد أدراج صف جديد )خالي من البيانات ( قبله  .نحدد أو نظلل الصف ال -1                   

 , عندها ستلاحظ أدراج صف جديد قبل الصف  Insertمن قائمة  Rowsنختار الأمر  -2                   

 . (1)الذي ظلل أو حدد في خطوة                        

                     ----------------------------------------------------------------------------------- 

  ) أعمدة ( : حيث يتم أدراج عمود  جديد خالي من البيانات قبل العمود Columnsالأمر  -2                  

 وكما يلي  : Excelالذي حدد أو ظلل مسبقا" في ورقة عمل                        

 

 جديد )خالي من البيانات ( قبله  . دد أو نظلل العمود المراد أدراج عمودنح -1                              

             جديد  , عندها ستلاحظ أدراج عمود Insertمن قائمة  columnsنختار الأمر  -2                             

 . (1)الذي ظلل أو حدد في خطوة  العمودقبل                                   

                  ---------------------------------------------------------------------------------------- 

               

 :العمل كما يأتي وطريقة( :فعالية يمين الماوسهناك طريقة ثانية لأدراج صف أو عمود جديد وهي)                

  

 نحدد الصف أو العمود الذي نريد أدراج صف أو عمود جديد قبله . نظلل أو -1                  

 ننقر بيمين الماوس على أية خلية ضمن خلايا العمود أو الصف المظلل عندها ستفتح قائمة  -2                  

 . ) أدراج (Insert, نختار منها الأمر أوامر                       
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                    --------------------------------------------------------------------------- 

 ثم أدرج عمود جديد Insertمستخدما" قائمة  Row3: أدرج صف جديد قبل  تمرين عملي                 

 مستخدما" يمين الماوس . C,Dيقع بين العمودين                                    

 : الحـــــــل                    

         L C on Row3→Insert→Row                                                         

                  L C on Column D→R C on any cells on column D→Insert 

 

---------------------------------------------------------------------------------------------------- 

            

 Insertوهو من الأوامر الموجودة على قائمة ) ورقة عمل (:Worksheetالأمر  -3                    

 حيث يتم أدرج ورقة عمل جديدة خالية من البيانات على                                                                    

 شريط الأوراق وحسب طريقة العمل التالية :                                                                   

 ننقر بيسار الماوس على ورقة العمل المراد أدراج ورقة عمل جديدة قبلها على شريط الأوراق  .1-                 

 , عندها سنلاحظ أضافة ورقة عمل جديدة  Insertمن قائمة  Worksheetنختار الأمر  – 2                 

 ) خالية من البيانات ( على شريط الأوراق .                        

                   ---------------------------------------------------------------------------------------- 

 

 : فعالية يمين الماوس(عمل جديدة على شريط الأوراق ,هي ) هناك طريقة ثانية لأدراج ورقة            

              

 ننقر بيمين الماوس على أسم الورقة المراد أدراج ورقة عمل جديدة قبلها , عندها ستفتح قائمة أوامر . -1             

 قر فيه على آيكونة عندها يظهر مربع حوار أن Insertنختار من قائمة الأوامر الأمر  -2              

                    Worksheet  ثم أنقر على مربعOk   عندها ستندرج ورقة عمل جديدة قبل ورقة العمل , 

 .  (1)التي حددت في خطوة                     
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 1تقع بين ورقة ثم أدرج ورقة عمل جديدة  3أدرج ورقة عمل جديدة قبل ورقة  تمرين عملي :

 وفي المطلب الثاني  Insertمطلب الأول قائمة , مستخدما" في ال  2وورقة                   

 فعالية يمين الماوس :                  

 

 الحل :

LC on Sheet 3→Insert→Worksheet                   

 

RC on Sheet 2→Insert→LC on Icon Worksheet→OK 

 

 

 لأدراج خلايا  Insert) خـلايـا (:  يوجد أمر الخلايا على قائمة أدراج Cellsالأمر  -4

 جديدة خالية من البيانات وكما يأتي :                                      

 : والخطوات العملية لذلك : (Insert)الطريقة الأولى : من قائمة أدراج     

 ترغب بأدراج خلية جديدة حولها .أنقر بيسار الماوس على الخلية التي  -1   

 بيسار الماوس . Insertمن قائمة  Cellsأنقر على الأمر  -  2                        

 من مربع الحوار الذي سيظهر أمامك ) أنظر لمربع الحوار في أدناه ( : -3                         
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 عندها نختار أو نفعل أحد الخيارات  الأربعة التالية :                       

 )نقل الخلايا الى اليمين ( . Shift cells rightالأمر  -أمـا  أ                        

 ) نقل الخلايا الى الأسفل ( . Shift cells downالأمر -أو   ب                        

 ) صف بأكمله , أي أدراج صف بأكمله ( . Entire rowالأمـر  -و   جأ                        

 ) عمود بأكمله , أي أدراج عمود بأكمله ( . Entire columnالأمر  -أو    د                        

                       

 . OKربع بعد أختيار أحد الخيارات الأربعة السابقة ننقر على م -4                        

 

                         -------------------------------------------------------------------- 

               

 وتتم كما يلي :الطريقة الثانيـة : فعالية يمين الماوس                  

 يا جديدة حولها .على الخلية المراد أدراج خلا ننقر بيمين الماوس -1                   

 , عندها ستظهر نفس قائمة الحوار في الطريقة  Insertستظهر قائمة أوامر نختار منها الأمر  -2                   

 .  OKنختار أحد الخيارات الأربعة الموجودة فيها  ثم ننقر على مربع الأولى                        

                      

                     -------------------------------------------------------------------------------- 

 ثم أعمل على تنفيذ المطاليب التالية :  (A1:C3)تمرين عملي : أدخل بيانات رقمية في المدى                     

 أعمل على أدراج صف جديد قبل الصف الذي  B2ة من خلال وقوفك على الخلي -1                                     

 . Insert, مستخدما" قائمة  B2تقع عليه الخلية                                           

 أعمل على أدراج عمود جديد يقع قبل العمود  B2من خلال وقوفك على الخلية  -2                                     

 , مستخدما" يمين الماوس . B2الذي تقع عليه الخلية                                           

 الى يمين  خلية جديدة تقع أعمل على أدراج B2من خلال وقوفك على الخلية  -3                                     

 . Insert, مستخدما" قائمة  B2الخلية                                           

 أعمل على أدراج خلية جديدة تقع أعلى الخلية  B2من خلال وقوفك على الخلية  - 4                                    

                                            B2 مستخدما " يمين الماوس , 

 (A1:C3)السؤال  الحـل : بعد أدخال بيانات رقمية في المدى المذكور في                    

     1-    B2 →Isert→Cells→Entire row→OK                                                                          
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                                            L C      L c    LC       Lc          LC       

               

2-    B2→Insert → Entire Column → OK                                  

                         R C      L c          LC                     LC              

 ) تترك واجب عملي في كتابة وتنفيذ الأيعاز للطالب ( . 4و  3أما الفرعين                  

            ----------------------------------------------------------------------------------------- 

 : سنتطـرق أليـه لاحقـا"المخططات أو معالج التخطيط ( : ) Chartالأمر  -5               

  

 

                       ------------------------------------------------------------------------------------- 

 

 تستخدم لتنسيق البيانات في كل من الصفوف والأعمدة والخلايا :   ( Format )قـائمـة  تنسيــق                  

 وأوراق العمل  وكما سنتطرق اليه فيما يأتي :                                                          

 يتم تنسيق الصف من النواحي التالية : صف : حيث Rowالأمر  -1                  

                      

                                               
 : حيث يتم تنفيذ الخطوة العملية التالية : Hideالأمر أخفاء  –أ               

 يتم كما يأتي :  3مثلا" لأخفاء الصف                     

                        L C on Row3 →Format → Row → Hide                     

 : حيث يتم أظهار الصف الذي تم أخفاؤه مباشرة وكما يأتي :  Unhideالأمر أظهار  -ب            

                              Format → Row → UnHide                     

 : يستخدم هذا الأمر لتغيير أرتفاع الصف , فمثلا" لتغيير أرتفاع  ( Hight )الأمر أرتفاع  –ج              

                   Row3 تفاع أعلى من الأرتفاع الحالي بحيث يستوفي البيانات الموجودة في خلايا هذا                    الى ار 

 الصف , والخطوة العملية لذلك كما يأتي :                    

 . 3ننقر بيسار الماوس على رقم الصف  -1               

 عندها سيظهر مربع الحوار التالي : Formatمن قائمة  Hightنختار الأمر  -2               
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 زيادة أو نقصانا" ثم ننقر نكتب من لوحة المفاتيح الرقم الذي يمثل الأرتفاع المناسب لهذا الصف -3              

                   OK  في أول العمل حسب أختيارك للرقم الذي يمثل . عندها سيتغير أرتفاع الصف الذي حددته 

 الأرتفاع الجديد .                  

 

 ي :هناك طريقة ثانية لتغيير أرتفاع الصف ,هي فعالية الماوس وكما يأتمـلاحظـة :                   

 ضع الماوس بين أزرار كاشف الصف )أرقام الصفوف ( للصف المراد تغيير أرتفاعه والصف  -1                  

 الذي يليه بحيث يتغير شكل مؤشر الماوس الى سهم برأسين .                      

 د الأرتفاع المناسب المطلوب .لتحدي للأعلى أو الأسفل أستمر بالضغط على الماوس مع سحبه – 2                  

 

                                   ---------------------------------------------------- 

 

 

 وحسب حيث تغيير عرضه وأخفائه وأظهاره  عمود : حيث يتم تنسيق العمود من Columnالأمر  -2             

 لكل من الأوامر التنسيقية للأعمدة التي تحدد أو تظلل مسبقا" " الخطوات العملية التالية                

                                                   
  Cالعمود  وة العملية التالية :مثلا" لأخفاءأخفاء : حيث يتم تنفيذ الخط Hideالأمر -أ

        L C on column C →Format → column → Hide               

       

 : حيث يتم أظهار العمود الذي تم أخفاؤه مباشرة وكما يأتي :  Unhideالأمر أظهار  -ب              

                              Format → column → UnHide                     

 فمثلا" لتغيير عرض ,  خدم هذا الأمر لتغيير عرض العمود: يست ( Width )الأمر أرتفاع  –ج              

                   Column B الحالي بحيث يستوفي البيانات الموجودة في خلايا       الى عرض أكبر من العرض 

 هذا العمود والخطوة العملية لذلك كما يأتي :                   

 . B ننقر بيسار الماوس على رقم العمود -1                

 عندها سيظهر مربع الحوار التالي: Formatمن قائمة  Widthنختار الأمر  -2                

                                                 
 نكتب من لوحة المفاتيح الرقم الذي يمثل العرض المناسب لهذا العمود زيادة أو نقصانا" ثم ننقر -3                  

                   OK ا سيتغير عرض العمود الذي حددته في أول العمل حسب أختيارك لأسم العمود  الذي . عنده 
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 .يمثل العرض الجديد                   

. 

 

 هناك طريقة ثانية لتغيير عرض العمود ,هي فعالية الماوس وكما يأتي :مـلاحظـة :                   

 العمود )عناوين الأعمدة ( للعمود المراد تغيير عرضه والعمود ضع الماوس بين أزرار كاشف  -1                  

 الذي يليه ) يقع على يمينه ( بحيث يتغير شكل مؤشر الماوس الى سهم برأسين .                      

 لتحديد العرض المناسب المطلوب .  لليمين أو اليسار أستمر بالضغط على الماوس مع  – 2                  

                  

 حيث يتم تنسيق ورقة العمل من حيث أعادة تسميتها أو أخفاؤها  : Worksheetورقة العمل  -3                  

                :                              وأظهاره                       

                                                                   
 :  sheet2:مثلا" لأخفاء أخفاء : حيث يتم تنفيذ الخطوة العملية التالية  Hideالأمر -أ   

        L C on Sheet2 →Format → sheet → Hide               

       

 : حيث يتم أظهار ورقة العمل التي تم أخفاؤها مباشرة وكما يأتي :  Unhideالأمر أظهار  -ب              

                              Format → sheet → UnHide                     

  

 : حيث يتم أعادة تسمية ورقة عمل الى أسم آخر جديد  (Rename)أعادة تسمية ورقة العمل  –ج               

 الى أسم ) صحة مجتمع( Sheet2مثلا" أعد تسمية  تالية :أختياره كما في الخطوة العملية اليتم                     

 العملية التالية : نتبع الخطوات                   

        L C on Sheet2 →Format → sheet → rename→                  →Entr   

           

 سميةهناك طريقة ثانية لأعادة تسمية ورقة العمل وهي فعالية يمين الماوس فمثلا" لأعادة ت                 

                 Sheet2 : الى ) صحة مجتمع ( نتبع الخطوة العملية التالية 

R C on Sheet2→Rename→Writ (              )→Enter                       

                   ------------------------------------------------------------------------------- 

 

 من  هاها من ناحية خطتنسيق بيانات الخلايا من خلال تنسيق: حيث يتم  (cells)الأمـر خلايـا  -4       

 ومن ناحية تنسيق خلفية أو أرضية الخلايا )تعبئة أرضية الخلايا بلون Font ) خلال تبويب)           

 :  وحسب الخطوات العملية التالية (Patterns)من خلال تبويب  تختاره (          
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 نحدد أو نظلل المدى أو الصف أو الصفوف أو العمود أو الأعمدة  أو ورقة العمل المراد تنسيق  - أ

 .(بيانات خلاياها ) حسب مطلوب السؤال      

 سيظهر لنا مربع الحوار التالي : Formatمن قائمة  Cellsنختار الأمر  - ب

                

                                                             
 تنا أو بعض منها )حسب المطلوب في يارا)خط ( ومنه نحدد جميع أخت Fontنختار تبويب  -ج     

 السؤال( لتنسيق بيانات الخلايا من أحد أو كل النواحي التالية :          

  أسم الخط :الموجودة تحت عنوانFont   "خط ( ) أختيارات مثلا(Arial , Arial  

    Black   ) الخ ...... , 

 , Regular,Italic,Bold, وهي  (Font Style)عنوان  تحت : الموجود نمط الخط*

                   Bold Italic. ) 

 .لخط أ  حيث نختار الرقم المراد من خلاله تغيير حجم,  Size*حجم الخط : الموجود تحت عنوان 

 .ر أي لون لخط البيانات حيث يمكن أختا (Color)*لون الخط : تحت عنوان 

  

 ستلاحظ عندها حصول جميع  . OKوبعد تحديد كل أو بعض الخيارات السابقة ننقر على مربع  

 التعديلات على البيانات التي حددتها في الخطوة الأولى على ورقة العمل . 

          ------------------------------------------------------------------------- 

 

 ونسق بيانات الخلايا من ناحية الخط ) لون وحجم ونوع ) درجات طلابية(  تمرين عملي: أفتح ملفك السابق

 : Formatمن قائمة تنسيق ونمط الخط  (                  
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 ثم نتبع الخطوات التالية : (A1:E4)الحل : نظلل البيانات بأكملها أي المدى 

 

Format→Cells →Font    →Color     →Size    →Font    →Font style   →OK     

   LC     LC          LC     LC          any       any     any      any        

Font            Font style                                    siz               Color 

    

 العملي للتنسيقات التي طلب في السؤال كما في الشكل أدناه : لاحظ الناتج                     
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  لاحظ التغييرات التي ظهرت على خط البيانات للتغييرات التي حددت في السؤال                    

 

 

 

 من ناحية ) النقـــــش (  : لنفس التمرين السابق أعمل على تنسيق بيانات الخلايا فقط تمرين عملي            

                          Patterns  من قائمة تنسيق Format). ) 

 الحـــل : نظلل البيانات المراد تنسيقها من ناحية تغيير لون الخلفية أو الأرضية لها ثم نتبع الخطوات             

 العملية التالية  :                        

Format→Cells→Patterns→any color→OK                                                         

 التي ستفتح بعد أختيارها من أمر تنسيق الخلايا : (patterns)لاحظ شكل نافذة النقش             
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 ( كما في  Patternsمع  Fontتطرأ على شكل البيانات التي تم تنسيقها ) لاحظ التغييرات التي س            

 الشكل التالي :            
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 لأجراء تنسيقات  ( tools Bar)الآيكونات الموجودة في شريط الأدوات  : يمكن أستخداممـلاحظــة    

 ه  , جعله غامقا" أو لا , جعله محاذاتيا لتغيير ) حجم الخط  ,نمطه  ,نوعه  , الخلالبيانات                   

 مائلا" أو لا , جعله غامق مائل ....... الخ (                  

              

 
        

 حيث تستخدم الرمز والآيكونات المدرجة أشكالها ووظائفها في أدناه لأجراء التنسيقات على بيانات  

 :  Excelلايا ورقة عمل خ 

  يستخدم لجعل الخط غامقا" . الرمز 

 

  يسستخدم لجعل الخط مائلا" . الرمز 

 

  يستخدم لوضع خط أسفل البيانات المكتوبة . الرمز 

 

  يستخدم لتغيير حجم الخط وذلك بالنقر على رمز السهم الموجود بجانب الرقم وأختيار  الرمز 

 وب أختياره لغرض تعديل حجم الخط .المطل الرقم                

             

 

   يستخدم لجعل خط البيانات بمحاذاة يمين الخلايا المكتوبة تلك البيانات بداخلها .  الرمز 

 

  يستخدم لتوسيط خط البيانات المكتوبة داخل الخلايا المراد تنسيق خط بياناتها .  الرمز 

 

  ذاة يسار الخلايا المكتوبة تلك البيانات بداخلها .يستخدم لجعل خط البيانات بمحا الرمز 

 

  به وذلك بالنقر على رمز يستخدم لأختيار أسم الخط المراد كتابة البيانات  الرمز

 السهم الموجود داخل هذا الرمز ثم أختيار أسم الخط المطلوب أستخدامه .

 

  على رمز السهم ثم النقر على يستخدم لأختيار لون الخط المطلوب أستخدامه وذلك بالنقر  الرمز

 أي مربع للون المطلوب تنسيق لون خط البيانات المطلوب وهذا الرمز يقابل أو يعمل عمل تبويـــب  

 ( من قائمة تنسيق للخلايا .  Font) خط 

 

  يستخدم هذا الرمز لتعبئة خلفية أو أرضية الخلايا في ورقة عمل  الرمزExcel  أي أن هذا(

 ( من قائمة تنسيق للخلايا .Patternsقابل تبويب )نقش الرمز يعمل أو ي
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 يمكن أستخدام واحد أو أكثر أو جميع الرموز المذكورة في أعلاه وذلك حسب مطلوب السؤال حظـــة :ملا

 . Excel لتنسيق بيانات الخلايا في ورقة عمل                

 

 

 هو عبارة عن أظهار بيانات ورقة العمل  (chart)التخطيط :  ( Chart Wizard )معالج التخطيط  

 من أنشاء تخطيط  Excel, حيث يمكننا برنامج  في رسم بياني                                                    

 على نفس ورقة العمل حيث تكون البيانات والتخطيط على نفس                                                     

 ورقة العمل أو يمكن أنشاء التخطيط على ورقة عمل جديــــدة                                                      

 ( Chart sheetتدعى ) ورقة التخطيط                                                      

 

 أو من آيكونة معالج التخطيط  Insertأدراج  الطريقة العملية لأنشاء التخطيط هي أما من قائمة                

 الموجودة على شريط الأدوات وسنبين ذلك كما يأتي في أدناه :                

 

 والخطوات العملية لذلك كما يأتي :     Insertأمـــــــــا قائمــة أدراج                   

 

 . من خلال معالج التخطيطسمها أو نحدد البيانات المراد ر نظلل -1                 

 . الماوس بيسار Insertننقر على قائمة أدراج  – 2                 

 المفتوحة . Insertمن قائمة  Chartنختار الأمر تخطيط – 3                 

 بع مراحل سيظهر مربع الحوار الأول والذي يمثل الخطوة الأولى من أصل أربع خطوات أو أر -4                 

 (Chart wizard –step 1of 4 – chart type)) الأسم الذي يحمله مربع الحوار الأول هذا هو                    

 نوع المخطط  : ومن هذه النافذة أنقر على أي شكل من الأشكال ثم أنقر على مربع                        

 ى مربع الحوار التالي أو المرحلة الثانية من مراحل أنشاء مخطط .( للعبور ال Next)التالي                      
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 من مربع الحوار الثاني ) الخطوة الثانية في أنشاء مخطط والتي تحمل أسم البيانات المصدر للتخطيط  -5              

                    Chart wizard –step 1of 4 – chart source data)  حيث يتم في هذه النافذة تحديد أيا" من ) 

 وأيا" تأخذ المحور الأفقي الصادي الموجب والذي   (Row )تأخذ المحور السيني الموجب  البيانات                    

 , وفي كل تعديل  3رقم للعبور للنافذة Next ثم ننقر على مربع التالي   (column)يمثل العمود                     

 لمحاور البيانات سيعدل ذلك مباشرة في مربع المعاينة لهذه النافذة لاحظ  شكل النافذة في أدناه :                    

 

 

                                    
              

 والتي تحمل أسم خيارات التخطيط  من مربع الحوار الثالث ) الخطوة الثالثة في أنشاء مخطط  -6             

                 Chart wizard –step 3 of 4 – chart  Options) فذة على ا( حيث تحتوي هذه الن 

 عدة تبويبات كل تبويب يمثل خيار يمكن التعديل عليه وأختيار ما يطلب تنفيذه :                  

  يحمل أسم عنوان التخطيط التبويب الأولtitls  حيث يوضع فيه عنوان للمخطط بأكمله وعنوان 

 للمحو السيني الأفقي  وعنوان للمحور الصادي العمودي .     

  المحاور ( التبويب الثاني يحمل أسمAxes   حيث يمكن تفعيل أو عدم تفعيل تقسيمات كلا المحورين ) 

 السيني والصادي .     

  خطوط الشبكة ( التبويب الثالث يحمل أسمGridline حيث يمكن تفعيل أو عدم تفعيل خطوط السبكة ) 

 الرئيسية أو الثانوية لكلا أو أحد المحورين السيني أو الصادي .     

 وسيلة الأيضاح االتبويب الر ( بع يحمل أسمLegend حيث يمكن أظهار أو أخفاء وسيلة الأيضاح )

 وفي 

 لى أو أسفل أو يمين أو يسار ( المخطط المرسوم نختار موقع وسيلة الأيضاح  ) أعحالة تفعيل أظهارها     
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 وفي كل أختيار نلاحظ المعاينة مباشرة داخل النافذة .     

  علامات البيانات( التبويب الخامس : يحمل أسمData Labels حيث يتم تفعيل أو عدم تفعيل أما أرقام ) 

 ى شكل المخطط الذي أخترناه من القيم أو مسميات المحور السيني أو مسميات المحور الصادي عل    

 . 1الخطوة  رقم     

  منضدة البيانات ( التبويب السادس : ويحمل أسمData Table حيث يمكن من خلاله تفعيل أو عدم ) 

 أضافة أو عدم أضافة  جدول البيانات أسفل المخطط المرسوم تفعيل     

 

 للعبور الى  Nextها يتم النقر على مربع التالي وبعد تنفيذ كل التبويبات الستة أعلاه أو أي عدد من    

 المرحلة الأخيرة ) مربع الحوار الرابع ( .    

                     
 

 من مربع الحوار الرابع ) الخطوة الرابعة في أنشاء مخطط والتي تحمل أسم موقع التخطيط    -           7     

                      Chart wizard –step 4 of 4 – chart  Location )  ) حيث يتم أختيار موقع المخطط 

 أو نضع المخطط على أي ورقة عمل نختارها  ( As new sheet )أما على ورقة عمل جديدة                      

 ربـــــــــــع ... الخ . وبعد أختيار أحد الخيارين السابقين ننقر على م  Sheet2أو  Sheet1أما                      

 ( عندها سيظهر المخطط الذي أخترته بكافة الأختيارات التي أخترتها في مراحل  Finish) أنهاء                      

 الرسم الأربعة . لاحظ شكل نافذة المرحلة الرابعة في أدناه :                      
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 وذلك بالنقر على آيكونة   Tools Barالطريقة الثانية  لأدراج المخططات هي : من شريط الأدوات                

 ظهر نفس) بعد تحديد أو تظليل البيانات المراد تحويلها الى مخطط ( عندها ت  معالج المخططات                 

 مربعات الحوار الأربعة السابقة  وننفذ كافة التبويبات المراد تفعيلها في كل مرحلة من مراحل الرسم .                

          

             

 أفتح ملفك السابق ) درجات طلابية( وأعمل على رسم هذه البيانات موضخا" وباستخدام  تمرين عملي :          

 أحد أنواع المخططات العلاقة بين أسماء الطلبة ) ولتكن مرسومة على المحور السيني (                            

 والمواد الدراسية ) ولتكن مرسومة على المحور الصادي الموجب (  مستخدما" قائمة أدراج                            

                             Insert : 

                                Chartثم الأمر    Insertحـــل : نظلل أسماء ودرجات الطلاب بعد فتح الملف ثم ننقر على قائمة ال            

                             

                      

 
 

 

 مل وكما عى نفس ورقة الحل الأربعة سيتم تنفيذ وظهور رسم المخطط علوبعد تنفيذ وعبور كافة المرا             

 :يأتي                
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                  ----------------------------------------------------------------------------------------- 

 

 في الأطار المحيط بيسار الماوس لتظهر المقابض بعد ظهور المخطط يمكن النقر  -1 مـلاحظــات :                

 للمخطط لنتمكن من تكبير وتصغير حجم المخطط بالشكل الذي نريده .                                     

 

 يمكن النقر بيمين الماوس داخل أطار رسم المخطط عندها ستظهر قائمة أوامر يمكن  -2                                 

 من خلالها تنفيذ العديد من الخيارات منها تنسيق مساحة المخطط ) أي أختيار لون                                       

           ( وتنفيذ ودخول أي مرحلة من مراحل Format chart Areaلمساحة المخطط                                       

 أو كل بعض خيارات تلك النافذة أو المرحلة ثم النقر  الرسم الأربعة لتغيير بعض                                      

 كم يمكن نسخ أو قص أو مسح المخطط أو عمل أطار  OKعلى مربع موافق                                      

 :(  chart window) خيار  للمخطط وجعله نافذة                                      

                                                                          
                          ----------------------------------------------------------------------------- 
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 أعمل على  وظهوره على ورقة العمل ية (تمرين عملي : بعد أن رسمت بيانات ملفك ) درجات طلاب                   

 ونوع المخطط وبقية كافة الخيارات التي ستظهر على قائمة  تغيير حجم المخطط                                       

 . طط الذي رسمته خعلى المالأوامر التي ستفتح                                      

 

                      ---------------------------------------------------------------------------------- 

 

 

 الأسبوع الحادي عشر الى  الأسبوع العشرين                

 

 هو عبارة عن نظام متكامل من البرامج الأحصائية المختلفة يتم من :  SPSSالبرنامج الأحصائي  

 خلاله قراءة البيانات وتحليلها وعرض وطباعة البيانات والمعلومات                                       

 الناتجة  من خلال هذا التحليل .                                      

 : SPSSتشغيل برنامج  

 ) وبعد تنصيب   Windowsمن خلال شاشة  SPSS يتم تشغيل برنامج                               

 البرنامج( كما يأتي :                               

                                          Start→programs→Spss for windows→spss 10.0  

 

 : تتكون شاشة  أو نافذة البرنامج على المكونات والأشرطة التالية : SPSSمكونات شاشة 

  

 الذي يتصدر كل نافذة والذي يحتوي في أقصى اليمين على :وهو العنوان  Title Barشريط العنوان  – 1  

 الثلاثة المعهودة لكل نافذة ) الأغلاق والتكبير والتصغير             الأزرار                                           

 . SPSSلنافذة والأغلاق المؤقت ( وفي أقصى اليسار على أسم ا                                           

 

 :  ويحتوي على العديد من القوائم والتي تمثل كل منها قائمة من menu barشريط القوائم الرئيسي  -2 

 الأوامر الرئيسية الخاصة بالتعامل مع هذه النافذة ومنها :                                                  

                                                               ((File, Edit, View,Data,….             

 

 : ويحتوي هذا الشريط على آيكونات تعمل عمل أحد الأوامر   ( standard Bar)الشريط القياسي  -3

 الخاصة بأحد قوائم الشريط السابق .                                                     

 

 : ويكتب في هذا الشريط أسم المتغير ) العمود ( ورقم السطر ) الصف ( (State Bar)شريط الحالة  -4

 . ( Data View )في كل خلية موجود عليها المؤشر في نافذة                                          

 

 متن متغير ) أي يتكون الجدول أو (Varible)والأعمدة  Caseالجدول الخاص بالصفوف )الحالات(  -5

 ( مع عمود ) متغير caseمن خلايا تمثل المكان الذي نتج عن تقاطع حالة )صف  SPSSنافذة      

     Varible   . ) 

 

 نافذة  (Data View)مع وجود أسمين لنافذتين هما  أشرطة التمرير ) نحو اليمين ونحو اليسار (  -6

 ات .عرض المتغير ( Variable View)عرض البيانات ونافذة      

      ------------------------------------------------------------------------------------ 



 61 

 

 بينما يسمى الصف في شاشة  ( variable)بالمتغير  SPSSيسمى العمود في شاشة  -1: ملاحظة       

                        SPSS  بالحالة(Case ) . 

 فأن هذا النظام سيفتح تلقائيا" على نافذة شاشة عرض البيانات  SPSSعند فتح شاشة  -2                    

                        (Data View ) . 

 ننتقل الى نافذة عرض  SPSSلغرض أدخال عناوين البيانات ومواصفاتها على شاشة  -3                     

 في  Variable Viewوذلك بالنقر على شاشة  ( Variable View)المتغيرات                           

 .  SPSSأسفل نافذة                           

       ---------------------------------------------------------------------------------------- 

 :) ورقة ملحقة (  SPSSلاحظ شكل نافذة برنامج          

 

 

  

 : SPSSأدخال البيانات في نظام  كيفية    

 

 عرض المتغيرات ثم الأنتقال    ( Variable View )من خلال شاشة نافذة يتم أدخال مواصفات البيانات 

 فمثلا" لأدخال عناوين مثل اللأسم (Data View)معلومات  البيانات على شاشة عرض البيانات  لأدخال

(name)  والعمر(Age)  واللون(color) يفة والوظ(Job) : الخ من أسماء العناوين للبيانات ...... 

   

حيث نكتب في الخلية الأولى التي تقع في                         (Variable View)ننتقل الى شاشة عرض المتغيرات  -1 

الأسم ثم نكمل مواصفات الأسم على هذا   (name)الصف الأول والعمود الأول نكتب أسفل عنوان كلمة 

وفي هذا الحقل أو هذه الخلية نحدد نوع  (Type)ف الأول العمود الثاني والذي يحمل عنوان نوع الص

عددي وننتقل الى العمود الثالث لنفس الصف الأول وتحت عنوان         أم  (String)البيان هل هو نصي 

لخاص بأسماء عمود احيث يوجد سهمان صعودا" أو نزولا" لزيادة أو نقصان عرض ال (Width)العمود 

 البيانات وهكذا الى أن نكمل بقية مواصفات العنوان الأول .

 

 وذلك بالنقر على أسم هذه النافذة الموجودة أسفل   (Data View)ثم ننتقل الى شاشة عرض البيانات  -2

 ا" في شاشة عرض البياناتالذي حددنا مواصفاته سابق (name)لكتابة أسماء العنوان  SPSSبرنامج      

 كما نكتب أعمار الأشخاص تحت عنوان العمر بالتتابع وهكذا مع ملاحظة وبعد أدخال  (1)في خطوة     

 . Excelمن لوحة المفاتيح لتثبيت المعلومة كما في برنامج   Enterكل بيان نضغط على مفتاح     

 

 ------------------------------------------------------------------------------------------ 

 

 نتبع الخطوات العملية التالية :حفظ البيانات المدخلة لأول مرة :   

                                 File →Save as →write File name→Save      

 

 

 نتبع الخطوات العملية التالية :  حفظ البيانات بعد أجراء تعديل عليها :   

File →Save                                       ولا بد أن تكون شاشة محرر البيانات 

                                                 (Data View ) هي الشاشة الفعالة . 

 .(متشابهان  Excel, SPSSبعد تعديل  للبيانات في كل من  ) لآحظ أن  كلا الأمرين حفظ بأسم وحفظ    
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) لاحظ أختلاف طريقة العمل في :  نتبع الخطوات العملية التالية: يانات جديد أنشاء أو تكوين ملف ب

SPSS  عنها في برنامجExcel ) 

      File → New → Data                                                

  

 : نتبع الخطوات النتالية : فتح ملف بيانات مخزون مسبقا"

File → Open →Data → L C on file name → OK           عندها سيفتح الملف الذي أخترنا 

  فتحه .           

 ( Excelعنها في برنامج  SPSS) لاحظ أختلاف طريقة العمل في              

 

     ----------------------------------------------------------------------------------- 

 

 نتبع الخطوات العملية التالية : ( Go to Case ) مباشرة : (case) الأنتقال الى حالة     

  

 .  Go to Caseننقر على الأمر    Dataمن قائمة  -1    

 رقم الحالة  Case numberأكتب داخل مربع رقم الحالة  Case  numberسيظهر مربع جوار  -2               

 .  OKل اليه , ثم أنقر على مربع ) الصف ( الذي تود الأنتقا                 

 

             Data→Go to Case→write number Case →OK                         

 

 عندها سيتم الأنتقال مباشرة الى رقم الحالة الذي حددته في مربع رقم الحالة .                    

                  -------------------------------------------------------------------------------------- 

 Editالمراد نسخها أو نقلها ثم ننقر على قائمة  نحدد أو نظلل البياناتنقل ونسخ البيانات :                  

 لصققة طقص ثم نحدد بداية من Cutنسخ أو الأمر   copyثم نختار الأمر                                            

 . Pastثم نختار أمر لصق   Editالبيانات ثم ننقر على قائمة                                            

 ( . Excel , SPSS) لاحظ تشابه كل من أمري النسخ والقص في كلا البرنامجين                 

            ------------------------------------------------------------------------------------- 

 نحدد المتغير أو العمود أو مجموعة المتغيرات:  Delete Variableحذف متغير ) عمود (                  

 . Clearثم نختار الأمر  Editالمراد حذفها ثم ننقر على قائمة                   

                         LC on name Variable →Edit→Clear                          

                    ---------------------------------------------------------------------------------- 

 نحدد أو نظلل الحالة أو الحالات المراد :  Case  :Delete Caseحذف الحالة ) الصف (                    

 .  Clearثم نختار الأمر  Editحذفها ثم ننقر على قائمة                                                

                         LC on name Case →Edit→Clear                          

 

 المتغيرات والصفوفهو امر حذف SPSS  (Clear )) لاحظ أن أمر الحذف في برنامج                  

 ( Excelوالذي يقابل أمر المسح أو التنظيف في برنامج                    

                      

                 ------------------------------------------------------------------------------------------ 
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 تبع الخطوات التالية :: ن   (Insert Case)أدراج حالة                             

 نحدد او نظلل الحالة ) الصف ( المراد أدراج حالة جديدة تقع قبله . -1                        

 ظهر صف فارغ جديد يقع فوقسي Insert Caseنختار الأمر  ثم Dataننقر على قائمة  – 2                        

 .( (1حددت في خطوة  الحالة التي                              

                  L c on case name→Data→Insert Case                         

                       ------------------------------------------------------------------------------- 

 الخطوات التالية : : نتبع(Insert Variable)أدراج متغير                       
 ) العمود ( المراد أدراج متغير جديد تقع قبله .  رنحدد او نظلل المتغي -1                         

 سيظهر متغير فارغ جديد يقع قبل Insert variableنختار الأمر  ثم Dataننقر على قائمة  – 2                        

 بعطي أسما" تلقائيا" SPSS( علما" أن برنامج  (1متغير أو العمود الذي حدد في خطوة ال                              

 يمكن تغيير الأسم  أن أردت ذلك . (VAR 0001 )للمتغير الجديد يحمل أسم                               

 

  Data→Insert  Variable                            →L C on Variable name 

 

                         --------------------------------------------------------------------------------- 

          

 SPSSوأدراج الحالة في  Excelملاحظـــــة : لاحظ الفرق الكبير في أمري أدراج صف في                   

 . SPSSوأدراج متغيرفي  Excelعمود في  وأمر أدراج                                   

                                   -------------------------------------------------------------------- 

 

 : نتبع الخطوات العملية التالية :SPSS (Fonts)تغيير نمط خط البيانات في                     

 

 نحدد البيانات المراد تغيير نمط خطها ) نظلل ( . -1                     

 . Fontثم ننقر على مربع خط  Selectثم نختار الأمر  Viewننقر على قائمة  -2                     

 ونمط الخط  Font typeمانريد أن نغيره من نوع الخط  رمن مربع حوار خط نغي -3                     

                       Style Font    وحجم الخطSize Font  ولون الخطColor Font    وفي كل أختيار نلاحظ 

 مربع المعاينة .                         

 .  OKننقر على مربع  -4                      

 

 L C on Range ( cases)→View→Select→Font→L c on any (type,size,..)→OK          

   

         --------------------------------------------------------------------------------------------- 

 

 ونمط تغيير الخط في برنامج Excelـة : لاحظ الفرق الكبير في أمر تغيير نمط الخط  في برنامج ملاحظـ            

                                   SPSS . 

                       ------------------------------------------------------------------------------------- 

 

                      

 )  تـــــــم بحمـــد اللـــــه تعالـــــــــــــــــــــى (                                    
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